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Introduction 
What is RPM? 
RPM Remote Print Manager® is a TCP/IP print server for Microsoft Windows platforms using native TCP/IP 
networking.  There are versions available for Microsoft Windows 95, 98 and Millennium Edition, Windows NT 4.0, 
2000, and XP, and Windows 3.1. 
 
RPM allows your print clients to send print requests directly to a PC over a network. RPM supports the LPD Protocol 
for Internet printing, and the associated UNIX print commands lpr, pr, lpq, lprm, lp, and lpstat. 
 
RPM was designed to run, after initial setup, without manual intervention. 
 
RPM supports multiple named queues. It allows you to choose any printer available from Windows, and stores any 
print setup selected for that printer. It also supports fonts, margins, line wrap and many other text features. RPM allows 
you to send data directly to a printer without interpretation, and it can run a local program or save the file to disk 
instead of printing. 
 
RPM has been tested extensively with all the major PC network software including the Microsoft Windows for 
Workgroups TCP/IP, Novell, and Trumpet. RPM accepts requests from mainframes running MVS, CMS, and CICS; 
from UNIX workstations; and from PC clients. 
 
RPM is a fully featured and supported product, and is the only professional LPD server available separately from 
bundled networking suites. We believe it is the best LPD server available anywhere. 

What is LPR/LPD? 
LPR/LPD is the printing method most commonly used in TCP/IP networks. LPR/LPD is used extensively on university 
and business campuses where UNIX systems have been in place for a while; the new generation of mainframe and 
business workstation operating systems now supports TCP/IP and LPD as well. It is a computer-to-computer printing 
method, rather than PC-to-PC. LPR stands for Line Printer Request; it's the part that submits the print request. LPD 
stands for Line Printer Daemon; it's the part that receives and processes the request. A "daemon" is a server or agent. 
 
The LPD Protocol Specification is documented in RFC 1179, Line Printer Daemon Protocol, dated August 1990, edited 
by L. McLaughlin III. 
 
RFC stands for Request for Comments. The RFCs document Internet protocols, practices and proposed standards. They 
are available via anonymous FTP at http://www.ietf.org/rfc. 

RPM Features 
Named Queues 

• RPM supports multiple named queues (see "Queues" on page 13). There is no fixed limit to the number of 
queues. 

• Each queue has its own setup information. Queues operate independently of each other. Each queue has its 
own printer setup (page 53) and queue type (page 13). You can configure separate queues for the same printer, 
each with different characteristics. 

• Queue types (page 13) include text queues, which support many print options; pass-through queues, which 
send data directly to the printer; and filter queues, which run a program on your PC rather than printing 
directly. 

• At any time in RPM you can create a queue (page 19), rename a queue (page 20), delete a queue (page 19) or 
jobs in the queue (page 27), and edit the settings in an existing queue (page 19). 
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Print Options 
• RPM text printing supports all the print options available through standard Windows Print Setup dialog. Each 

queue uses its own print options, so you could create a number of RPM print queues, each with separate print 
characteristics to fully support your printing needs. 

• RPM supports both local and network printers for text and pass-through queue types. If Windows supports 
your printer, then RPM can print to it. 

• RPM supports printing the optional banner page; RPM also allows you to suppress printing banner pages for a 
queue without modify the host system. 

• RPM supports pr style printing, using the optional page headers. 
• RPM has many features requested by mainframe users, including suppressing trailing blank pages, removing 

null characters from a printout, line wrap options, lines per inch and characters per inch, overprinting, and 
scaling the font down to support a given line length. 

User Interface (UI) 
• RPM displays comprehensive information on queues (see "Queue List window" on page 23), active jobs in 

queues, jobs waiting in queues, print jobs (see "Print Status Window" on page 25), and all logged events (see 
"Log window" on page 25) in separate, independent windows. 

• Queue operations are available through the menus, but are hot-wired into the Queue Status window for 
convenience. 

• Queue Status and Print Status windows support Copy to clipboard (page 27). 
• RPM supports a wide range of logging options (page 21). 
• RPM uses a workbook interface rather than cascading windows.  Both the Queue List and Log windows are 

open when the RPM user-interface is initially started. 
• RPM displays dates and numeric data in Windows using the regional settings. 
• Only one RPM session runs at a time under Windows NT-based platforms. 
• RPM now runs in the background as a Windows service. The RPM UI does not need to be running to receive 

and print jobs. The child windows are for display purposes only, and they do not need to be open for RPM to 
operate. 

• RPM supports context sensitive help. You can get help for every window, menu item, and dialog by pressing 

the F1 key or using the Context Help  toolbar button. 

Support 
• RPM includes a number of features to facilitate problem solving, including copying window contents to the 

clipboard, and the extensive logging options. 
• Our policy is to resolve problems to the best of our ability, and to cooperate with other vendors. 
• We are very interested in your impressions of RPM. If there is anything we can do to make RPM more useful 

for you, please don't hesitate to contact us. See page iii for contact information. 

Requirements  
What does your computer need in order to run RPM?  If it runs Microsoft Windows and TCP/IP is installed, it will also 
run RPM.  Other requirements are needed depending on the usage of RPM. 

• An x86 compatible computer, 486SX minimum, Pentium recommended. 
• Microsoft Windows NT 4.0 Service Pack 4 or later.  Internet Explorer version 5.01 or later. 
• Windows Sockets version 2.0 or later compatible network software. Your system must have wsock32.dll. 
• Minimum RAM: 8 megabytes, suggest at least 32 megabytes depending on utilization of computer or 

operating system requirements. 
• 4 MB free disk space for installed executables and other files. 
• Adequate disk space for incoming print requests-recommended minimum 5 MB. 
• Optional: One or more printers configured to work with Windows. Printers are 'optional' because RPM can 

save files to disk or open them using a local program on your computer. 
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Installing RPM on Windows NT/2000/XP 
You must first log in as the local ADMINISTRATOR or a user that has privilege to install programs, COM servers, and 
services.  Next, execute the RPM setup and follow the instructions in the setup wizard to install the program files and 
set up the COM server and service databases. 
 
Here's the step-by-step install process: 

1. If you have RPM on a disk, insert the disk into your drive. Go to the Windows 'Start' menu and select “Run”.   
Type 'A:\setup.exe' and press OK.  If you have the downloaded RPM executable, simply double-click the file 
to begin installing.  You can also use “Add/Remove Programs”. 

2. Take note of the End User License Agreement. Please review it to make sure the terms are understood. Click 
either “Yes” or “No” to represent your acceptance of these terms. The setup program will continue only if you 
accept. 

3. The setup program presents a suggested path for the RPM directory. Change this path as needed, and click the 
OK button. The setup program shows you the space required for RPM, and the space available on the drive 
currently shown in the “Destination” field. 

4. RPM will now be installed. You will see a progress bar which shows the percentage completed, and messages 
that describe the various components. Setup then adds a RPM program group to the 'Start' menu.  A copy of 
the End User License Agreement is installed along with RPM program and help files.  

5. RPM is now on your disk. 
 
The RPM service is initially configured to run under the SYSTEM account.  RPM should be configured to run under a 
user account if required by your security policy.  It may also be necessary to run under a user account if RPM will be 
using shared resources, printers or folders.  To configure RPM to run under another user account: 

1. Create a user account for RPM using the Windows NT/2000 “User Manager”.  We recommend this user be a 
domain user.  Grant this user account the “Log on as a Service” privilege.  If NT service pack 4 or later is 
installed, this is done automatically. 

2. Under the “Start” menu, open the “Settings” menu and click “Control Panel”.  Then double-click “Services”.  
Highlight “RPM Remote Print Manager” and press “Startup…”. 

3. Select “This Account” and type the name of the user created in step 1.  You will need to type the password and 
confirm it. 

 
Now you need to give this user full access to the proper registry keys.  Perform the following steps.  If running RPM 
under the SYSTEM account, substitute SYSTEM for the RPM user account. 

1. In the Windows “Start” menu, choose “Run” and type “REGEDT32”.  Press OK. 
2. Highlight the key HKey_Local_Machine\Software\Brooks Internet Software 
3. Choose “Permissions” from the Registry Editor’s “Security” menu. 
4. Add the RPM user account, give Full Control, and set the Replace Permissions on Sub Keys. 
5. Exit 

 
Notes: 

 If an existing LPD software package is already running, this will need to be disabled.  Check the 
documentation for instructions on disabling it. 
 Even though RPM can print using only “Print” access permissions, you should still give the RPM user 
account full access to all local and shared printers.  The SYSTEM account can only access shared 
resources if the computer sharing the resource allows. 

Removing RPM 
• Log in as Administrator or equivalent.  Open the Control Panel and double-click “Add/Remove Programs”. 
• Select “RPM Elite” or “RPM Select” and click the “Add/Remove” button. 
• RPM saves the registry files for your queues.  To finish removing RPM completely, delete the “Brooks Internet 

Software” folder from your file system.  After this folder is deleted, queue configuration cannot be recovered. 
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Configuring Print Clients for RPM 
Minimum Requirements 
The minimum information you need to supply to your remote print client is the host name of your PC, and a queue 
name. For more information on these terms, see the Glossary in the back of this book. 
 

  Note: there is no default queue in RPM. You must create at least one queue. When RPM is started, and no queues 
are currently configured, the “Create a Queue” dialog is automatically displayed.  See page 36 for more information. 

What to Name Your RPM Queue 
When a print client makes a request for a queue that RPM believes is not defined, RPM automatically creates one.  This 
"auto-create" feature can be disabled in the Settings Dialog.  If "auto-create" is turned off and RPM receives a request 
for an undefined queue, RPM will deny the request. 
 
If RPM denies the request, messages will be logged.  To find the queue name the client is using, check the RPM log: 

1. Open the Log window if it is not already open, by selecting Log from the View menu or clicking the log tab at 
the bottom of the RPM window. 

2. On your remote system, rerun the command. 
3. At the bottom of the RPM log window, check for a message similar to this:  “Warning: Queue 'test' not 

defined.” 
 
In this example, test is the name of the queue requested by the remote client. You should reconfigure your remote 
client, create a queue (page 19) in RPM, or rename an existing queue (page 20).  You can also enable the “auto-create” 
feature in RPM (page 54). 

Choosing the Right Protocol for Your Client 
LPR/LPD is not the only print protocol on the Internet. RPM currently supports the LPD protocol, sometimes known as 
the Berkeley remote printing protocol. RPM also supports streams or reverse telnet: see page 56 for more information. 
 
Brooks Internet Software does not currently have access to all the varieties of systems our customers print from.  Use 
the following guidelines to select a protocol: 

• If you see a choice for LPD, pick that one. 
• If you see a choice for remote Berkeley or remote BSD, pick that one. 
• If you see a choice to emulate an LPR client, pick that one. 
• If you have a Berkeley compatible UNIX system, consult the printcap man pages for assistance. 
• If you have a System V compatible UNIX system, do not use lp; use Berkeley compatible.  Consult the 

documentation or local system administrator for details. 

Order of Control File vs. Data File 
Some LPD servers expect the control file to follow the data file(s); others may expect it to come first.  RPM will 
receive the print job either way. 

Client Port and TCP/IP Protocol 
Certain clients may not be able to follow the TCP/IP server conventions. See "LPD Security Dialog" on page 47 for 
more information. 
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Common Printing Problems 
To help diagnose problems and provide an activity record, RPM maintains a log and provides a window to it. The 
window is open by default.  To view it, click the date-stamped tab (i.e. 20020910.log) at the bottom of the RPM 
window.  If it is not open, select "Log" from the “View” menu. This window will contain a number of entries from 
RPM startup, including version information for RPM and Windows Sockets. 
 
This section refers frequently to “Edit Queues”, which is discussed in detail on page 38 

RPM Doesn't Print 
 

1. The log files says “Client port xxxx out of range!”  You must enable the options in the LPD Options dialog 
discussed on page 47. 

2. Is your print client connecting to RPM?  Whenever RPM is contacted for any reason it creates a log entry 
similar to "Information: Request from <address>" where "<address>" is the IP address of the remote machine.  
If you don't see an entry like this, your print client is not getting through to the PC. Please contact your 
network administrator for assistance. 

3. Are you using the right queue name?  LPD print requests always include a queue name. Prior to this 
version, RPM required the user to create a queue before RPM would handle requests for that queue. Now 
RPM can automatically create queues. 

4. Does the print request arrive, and sit in the RPM queue without printing?  If the print job says "100%" 
but doesn't print, does it also say "Xfer"?  If so, then RPM doesn't believe the print job is really sent. The 
"100%" just means the current portion of the print job; all print requests have at least two parts, some more. 

5. The log file says "received unknown subcommand" followed by other text. See #3.  If you are using a 
UNIX system, we have had it reported to us that rebuilding the "/etc/printcap" file can solve this. Your results 
may vary. 

6. The log files says "Error: Unable to print to <printer>" where "<printer>" is the name of your printer as 
defined in Windows. The most likely causes are that the printer or port definition is wrong, that the print 
driver can't be loaded, or that the RPM service doesn’t have permission to access the printer. Also, Windows 
may temporarily be unable to talk to the printer. Check the log, since we continue to add diagnostic 
capabilities to RPM. For now we suggest going to Edit Queues and running Printer Setup, checking the 
definition of your printer, and possibly selecting another printer.   

Other Printing Problems 
1. Boxes and odd characters appear at the top of the first page, or in the printout. Your print application is 

sending printer specific data to RPM. Go to the Edit Queues dialog; near the top, you will see three queue 
types. The first is "Print text, allows font selection, page setup". This is selected by default. You want to use 
the second type, "Pass data directly to the printer (raw)." 

2. I send PostScript files and they print as PostScript code. See #1. 
3. I've selected "Pass through", but one line appears at the top of each page. Go to Edit Queues, click Queue 

Setup, then click "Translate LF to CR/LF". 
4. There is no page between print jobs in my raw queue. Go to Edit Queues, click Queue Setup, then click 

"Add Page Separator". 
5. I need to get rid of the banner page. Go to Edit Queues, change the queue type to Text.  Click Queue Setup 

and check the "Never print the banner page" check box. 

Other problems 
Please contact us. We are doing everything possible to make sure that RPM works to everyone’s satisfaction. 
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Configuring RPM 
This topic provides a summary of the settings you can change in RPM, with pointers to the appropriate dialog Help 
topics. 

Hidden 
In RPM for Windows NT-based platforms, there are two distinct parts, the user interface (UI) and the service.  By 
default, the RPM service starts when Windows is booting up and performs all major functions such as receiving print 
jobs, processing and printing.  The UI is designed for configuring RPM and may remain closed during normal 
operation. 

Log File Expiration 
RPM creates a new log file each day in the "Logfiles" folder, a “child” directory under the RPM root directory. To keep 
your disk drive from filling, RPM will remove log files older than 7 days. You can modify this setting in the “Settings” 
dialog (see page 54). 

Log File Timestamp 
RPM timestamps each log event it records. 

Log Options 
By default, RPM enables network, print, and queue logging, but not “high detail”.  Consult the "Use logging options" 
section on page 21 for more information on these topics. 

If your RPM installation is running smoothly, you can turn off all the logging options.  When all options are turned off, 
RPM will log warning and error messages, and trial status messages during the initial trial period. 

If you are experiencing problems, we advise you turn on all the logging options until the problem is identified and 
resolved. 

Security 
In RPM, security consists of performing basic checks on new requests as advised in the LPD Protocol Specification or 
commonly implemented in a UNIX LPD server. Some print clients are not able to meet these requirements, however. 
The “LPD Options dialog” topic on page 47 will advise you on how you can tell if you need to adjust these settings. 
 
By default, these defaults are relaxed to allow non-standard print clients to easily connect to RPM.  After upgrading 
from previous versions of RPM, these options must be relaxed manually. 
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Operations Guide  
This section goes beyond menus and dialogs. The intent is to show you what happens to your system when RPM runs, 
what files are created, and how RPM uses them. 

Starting RPM 
RPM performs a number of functions every time it is started.  Each time you start the RPM UI, it does the following: 

• It loads a number of settings from the Windows registry. 
• It launches the RPM service if it is not already running. 
• It connects to the RPM service for live configuration, status, and log information. 
• It prompts you to create queues if you haven’t already done so. 
• The Queue Status and Log windows are opened.  

 
When the RPM service is started, it performs the following actions: 

• It executes the installation functions to make sure RPM is installed properly and is ready to use. 
• It loads a number of settings from the Windows registry. 
• It attempts to connect to Winsock and register itself as a print server. If it cannot, it logs a warning 
• If at least one queue is configured, RPM performs a queue cleanup, partially transmitted jobs are removed, and 

jobs that were printing are held so that they can be printed later. 
• Finally, RPM checks for jobs ready to print. 

Exiting RPM 
When you exit the RPM UI, the following actions take place: 

• The UI detaches from the RPM service. 
• The current size, location, and show status (icon, normal, etc.) of the RPM window is saved. 
• The RPM window is closed. 

When you stop the RPM service, the following actions take place: 
• Any attached UI is closed. 
• All the current transfers and requests are canceled, and incomplete jobs are removed. 
• The network is informed that RPM will no longer be a print server. 

Files Created by RPM 
  Note: These files are those created and deleted during the course of operation.  For a discussion of files that are 

more or less permanent, consult "Files used by RPM" on page 12. 
 
When RPM receives a print request, it receives multiple parts. One part is called a control file. It contains information 
describing the print request, including the title, the user ID, and instructions for printing it. 
 
The other part(s) of the request are the data file(s) to be printed.  Data files are stored in the “spool” directory, a child 
folder to the RPM root. The data file name is specified by the LPD protocol.  Usually it is 'dfA' followed by a sequence 
number, and the name of the host that sent the file (i.e. dfAwww.brooksnet.com). RPM will not overwrite files in the 
case of duplicate filename; rather it adds a “-1”, “-2”, etc. 
 
The user can specify that control files from the host be saved.  In this case, RPM saves the control data in a text file 
using a similar name to that of the data file.  This file begins with "cfA", and has a ‘txt’ extension. 

Files Used by RPM 
Unlike earlier versions of RPM, the current version of RPM does not create or maintain initialization (.ini) files. Instead 
RPM uses the Windows registry. 
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  Note: We strongly recommend that you do not change the Windows registry without first making a backup of the 
current registry contents. You may damage your Windows system or make your computer unbootable. 

Queues  
This section is devoted to giving you a better understanding of queues. This is an important topic for two reasons: 

1. Queue management is one of the key features that sets RPM apart from other Windows-based LPD servers, 
and from hardware print servers 

2. Understanding queues is crucial to getting the most value from RPM. 

Queue Types 
The current version of RPM supports three types of queues.  The following discussion addresses these queue types, and 
provides information on their use. 

Text queue 
Description: Text queues offer a wide variety of printing options, including the ability to set fonts, margins, line wrap, 
maximum page length, and many others. 
When to use: If you want RPM to read your text and render it using Windows features, then a text type queue should 
be used. 

Pass-through queue 
Description: Pass-through queues send print files directly to the printer, without interpretation. These queues still use 
the Windows Spooler as Microsoft recommends. 
When to use: If the print jobs is formatted before RPM receives it,  or files meant for a specific printer (including PCL 
or PostScript files), then a pass-through or “raw” type queue should be used. 
 

  Note: RPM currently ignores any settings currently selected in the print driver properties.  Options such as 
orientation and paper size are included in the data stream and cannot be modified by RPM in raw queue types. 

Filter queue 
Description: Filter queues can execute a program on your computer, or save the data to a folder located on the 
computer or local network (in the case of file sharing), rather than sending the print job directly to the printer. 
When to use: If special processing is needed which are best met by using another program in conjunction with RPM, 
then use a “filter” type queue.  For instance, filter queues are used in any of the following situations: 

• Printing PostScript files, but using a local PostScript rendering tool, like GhostScript, as an alternative to a 
PostScript printer. 

• Sending word processing files to RPM for local printing, a local word processing application can be invoked 
to print the file to your Windows printer. 

• If sending a file to a local computer to perform some function other than printing, for example, updating a 
database or spreadsheet or simply saving the file to disk. 

Queue States 
RPM provides several operating modes for queues that control how they accept and process requests. These modes are 
referred to as states.  Think of a state as something that stays the way it is until you change it. 

Enabled or Disabled 
Description: When a queue is enabled, it accepts requests from remote print clients. When a queue is disabled, RPM 
will report an “access denied” message to the remote print client. 
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When to use: A good way to take a queue off-line is to disable it. For instance, when performing a full backup of your 
disk, or when RPM is spooling to a network drive and that network is currently not available, it may make sense to 
disable the queue temporarily. 

Processing or Suspended 
Description: When a queue is suspended, RPM will receive jobs, but not print the waiting jobs.  Print requests will 
remain in the queue until it is resumed. When you resume the queue, all waiting jobs will print unless they are on hold. 
 
When to use: If a printer or filter program is temporarily unavailable, it makes sense to suspend the queue. 
 

  Note: if you suspend a queue, take care not to let your disk become too full. 

Holding or Not Holding 
Description: When a queue is holding, all jobs sent to that queue will be held. Later, when the queue is un-held, each 
job that was received while it was holding will be held until manually released via the Operator Job Control dialog (see 
page 48). 
When to use: If you want to start jobs printing on a page other than the first, or if you wish to supervise the printing, 
then consider holding the queue. 
 
The following table shows the queue states, describes them and also tells when to use them. 
Mode Description When to Use: 

Enabled Accept incoming requests Normal mode for operation 
Disabled Deny incoming requests When performing backups, etc. 
Resume Process incoming data Normal mode for operation 
Suspend Do not process incoming data When printer is disabled for a period of time 
Not Holding Send print jobs to printer Normal mode for operation 
Holding Don't send jobs to printer Start printing on different page, or control printing 

How to Determine Queue States 

Queue List Window 
The Queue List window shows the current states for each queue with checkboxes, labeled Enabled, Suspended, Held.  
For normal operation, only Enabled should be selected.  This window supports modifying the queue states by simply 
toggling the checkboxes. 

Queue Status Window 
The Queue Status window shows the current states for each queue.  This window does not support modifying the queue 
states, except through the right-click menu discussed below.  An example from the queue status window follows: 
 Queue lp: Enabled, Processing, Not Holding 
 

  Note: The Queue Status window is legacy and will be removed in future RPM versions. 

The Queues menu 
If the Queue Status or Queue List windows are open and a queue is selected, then the checkmarks next to Enabled, 
Processing and Holding in the Queues menu show the current state.  This menu supports modifying the queue states by 
simply toggling the choices. 
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The Edit Queues dialog 
Select a queue in the Edit Queue dialog. The checkboxes in the General Setup group show the current states.  This 
dialog supports modifying the queue states by simply toggling the checkboxes. 

Right-click Menu 
In either the Queue Status or Queue List windows, RPM supports a right-click menu.  The menu has three queue state 
choices, including Enabled, Suspended, and Holding.  This menu supports modifying the queue states by simply 
toggling the choices. 
 

Host Access 
RPM is able to allow or deny access to other computers by using their Internet host name or IP address, and a set of 
rules that you supply. These rules and accompanying data are managed by the Host Access dialogs. 
 
Host Access is a tabbed dialog that gives access to three windows: 

• Host Rules (see page 43) allows you to enter hostnames and domain name patterns, and access control 
• IP Rules (see page 44) allows you to enter IP addresses and patterns, and access control 
• Host Names (see page 46) allows you to enter a local host table, which RPM will use to convert IP addresses 

to host names. Otherwise RPM will use the network to look up a host name 
 
This topic describes the overall host access security scheme. 
 

  Note: During initial configuration or troubleshooting, host access checking should be disabled which allows all 
print clients access to RPM.  Only after RPM has been configured properly should host access checking be enabled.  
Host access checking restricts printing, it does not enable it. 

Access 
RPM optionally performs an access check for each connection it receives. Connections include print requests, queue 
status requests, and others. RPM is able to allow or deny access based on the identity of the remote computer. If access 
is allowed, then the request proceeds without the print client being aware that a check has taken place. If the access is 
denied, RPM returns the text "Permission denied." then closes the connection, effectively shutting off the request. 

Steps RPM uses when checking access 
1. Access checking enabled?  RPM uses a setting labeled “Enable host access checking” to determine whether 

or not to perform the access check. If this setting is off, RPM does not perform the check.  Enable host access 
checking is disabled by default, so that you do not have to create access rules to use RPM. 

2. Get the connected IP Address/Use IP address rules.  Whenever another program connects to RPM, 
Winsock provides to RPM the Internet address or IP address of the remote computer. RPM uses this 
information to search the IP rules you created. If a match is found, RPM uses the access control value (allow 
or deny) with this connection attempt. 

3. Search for hostname.  If no match is found in the IP Address rules, RPM uses the IP address to search for a 
host name. It first looks in the IP addresses you enter in the Host Names dialog, then in the IP addresses for 
which Winsock has returned host names in the current RPM session.   If RPM does not find the IP address and 
a matching host name in its records, then it makes a Winsock request to retrieve the host name. You may need 
to have reverse DNS lookup enabled at your site; contact your network administrator(s) for more information.  
If Winsock successfully finds a host name for this IP address, then RPM stores that association for later use in 
this session. 

4. Use hostname rules.  Assuming RPM has found a host name for the print client, it searches the host name 
rules you entered in the Host Rules dialog. If a match is found, then RPM uses the access control value for this 
connection request, as with the IP Rules match. 
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5. Use default access rule.  If no match is found in either the IP rules or Host rules, RPM uses the default access 
rule, either allow or deny, for this connection attempt. 

Rules 
RPM uses a series of rules that you create to determine whether or not a remote host has access. These rules consist of 
host names, domain name patterns, and IP addresses.  

Rule Searching 
RPM uses two sets of configurable rules: IP rules and Host rules. In each case, RPM starts with the first rule, and 
attempts to match each rule in order. RPM then uses the access value of the last rule matched. 
For example, let's assume the following set of rules: 
Rule  Access Host name or domain pattern 

1 Allow *.brooksnet.com 
2 Deny *.nicoh.com 
3 Allow *.shel.nicoh.com 
4 Allow africa.nicoh.com 

 
If we print from dave.dev.brooksnet.com, RPM finds a match in Rule 1, but continues to search the rules. No other 
rules match. 
 
If we print from s-03.shel.nicoh.com, RPM has the following results: 
Rule  Match Y/N Access 

1 N ? 
2 Y Deny 
3 Y Allow 
4 N Allow 

 
The result of this rule search is “allow”. 

Rule Matching 
Both host names and IP addresses come in parts separated by a period ("."); for example, the host name s-
03.shel.nicoh.com contains four parts: s-03, shel, nicoh, and com. RPM doesn't care how many parts there are. 
Similarly, the IP address 199.104.19.3 contains four parts, namely 199, 104, 19, and 3. For the purpose of pattern 
matching, RPM does not care how many parts there are in the name. 
 
The asterisk character (*) has long been used in the Internet as a wildcard for matching one or more "parts" of names or 
IP addresses. For instance, The domain pattern '*.brooksnet.com' matches both 'dave.dev.brooksnet.com' and 
'hp1.tech.brooksnet.com'. The asterisk matches "dave.dev" in the first example and "hp1.tech" in the second example. 
Similarly, the IP address pattern '199.104.19.*' matches '199.104.19.3', and the pattern '199.104.*' matches both 
'199.104.19.7' and '199.104.251.2'. 
 
By now you have probably noticed that the host name rules are matched from right to left, and IP rules are matched left 
to right. That is the Internet convention, which RPM uses as well. 

Default Access Rule 
RPM will use the default access rule if it cannot find a match in the IP rules or host name rules. 
IP addresses and host names 
 
Each computer using a TCP/IP network has a unique IP address. These addresses are either assigned individually by 
your network administrator, or automatically, perhaps with a DHCP server.  Each IP address also has a name associated 
with it. RPM is interested in the fully qualified domain name, that is, the complete path starting with the individual 
computer and ending with the domain. 
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Our recommendations for working with host names and IP addresses follow: 

• It is much easier to work with host names and domain patterns; unless you are the network administrator, in 
which case you probably know all the IP addresses and how they are grouped in your organization. 

• If you work with host names, then your PC needs to know where the DNS is located. This information will be 
part of your Winsock setup. DNS stands for Domain Name Service; it is the software and database that turns 
names to addresses and addresses to names.  

Recommendation 
We recommend that you use the most general rules first, followed by the more specific rules. In our rule searching 
example above we included the following: 
Rule  Access Host name or domain pattern 

2 Deny *.nicoh.com 
3 Allow *.shel.nicoh.com 
4 Allow africa.nicoh.com 

 
The most general of these rules is #2; access is ‘deny’ to each host at nicoh.com. Next we allow all hosts in 
"shel.nicoh.com".  Finally, the access for africa.nicoh.com is ‘allow’. 
 
What would have happened if we put Rule #2 after Rule #4? The host s-03.shel.nicoh.com would match 
*.shel.nicoh.com and the access would be ‘allow’. But, later it would match *.nicoh.com and the access would now be 
‘deny’. That would probably go against the intent. 

Styles 
Styles provide an easy way to store a queue setup, and conveniently restore it on demand. 

History 
The concept of styles grew out of a customer requirement. One clients needed to support four distinct print setups. We 
suggested that they create four queues, but they had already done so. Their problem was that each of their users had the 
same need for different print setups, and the job of remote administration to create these queues on the Unix host (4 * 
number of users) was becoming unmanageable; they preferred to have one queue per user. 
Our client requested that we make an easy way to "load" a queue setup on demand. RPM styles grew out of that. 
How to Use Styles 

1. Create a queue (see page 19), and set it up (page 19) to work well with one of your applications. 
2. Create a style (page 17), give it a name that ties in with your applications (e.g. "Transcripts"). 
3. Copy the queue setup to this style. 
4. To use this style, click on the RPM control menu (page 30) and select Use Styles (page 27). 

Translations 
RPM is able to perform character-by-character translations of your print data, prior to printing. This translation is 
independent of the queue type; in other words, you can translate text data, pass-through data, and data going to another 
program. 
 
For more information on the Translation Tables dialog, see page 61; for more information on the Character 
Translations dialog, see page 34. 

  Note: If you are translating pass-through data, we strongly recommend that you test your results. Some printers do 
not support the complete Windows character set. 
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Interesting Things You Can Do With Translations 

Swap line feed and carriage return 
Most host applications generate a line feed, or carriage return followed by line feed, for a line terminator.  Windows 
printers generally need both a carriage return and a line feed to signal the end of the line.  We have also seen a line feed 
followed by a carriage return.  Your printer may understand this, but the RPM text handling sees an extra blank line. 
You can make RPM do the swap by following these steps: 

1. Go to the Translation Tables dialog; from the Options menu, select Translations then Tables.  Or, go to the 
Edit Queues dialog; click “Print Data Options”, then “Edit Translations”. 

2. Create a table.  Call it CRLF Swap. Click the “Contents” button to create the translations. 
3. Put your cursor on the field Translate from / Enter hexadecimal characters. Click the CR button. Now click the 

LF button. That's the first translation. 
4. Now, click the LF button followed by the CR button. That's the second translation. 
5. Click OK in the Character Translations dialog, then OK until all dialog windows are closed. 
6. To use this translation, go to the “Edit Queues” dialog, click “Print Data Options”, select ‘CRLF Swap’ from 

the Translation table drop-down list, then select Use Translation. 
From now on, any queue that uses this translation will swap the CR and LF characters. 

Translate unused ASCII characters to accented characters 
You may want to translate certain characters to accented ASCII characters using the following data: 
Char From code (hex) To code (hex) New 

[  5b c4 Ä (AE) 
{  7b e4 ä  (ae) 
\  5c d6  Ö  (OE) 
| 7c f6 ö  (oe) 
]  5d dc Ü  (UE) 
} 7d fc ü  (ue) 
~ 7e df ß  (sz) 
@ 40 a7 §  (paragraph)

 
To perform this translation, create a translation table as described above, name it "German".   Now, go to the 
“Character Translations” dialog, put the cursor in the Translate from / Enter hexadecimal characters field, and type the 
following: 5bc47be45cd67cf65ddc7dfc7edf40a7 
 

  Note: Those are the ‘to’ and ‘from’ hex codes shown.  You do not need to click any buttons; RPM automatically 
enters the translations. 
 
When finished, save the table by clicking OK and configure your queue to use the "German" translation table, using the 
instructions described above. 

Translation Tables 
RPM stores translation information in named translation tables created by the “Translation Tables” dialog. This dialog 
allows you to create tables, rename existing tables, and delete tables. You can also edit the contents of the selected 
table. 

Character Translations 
RPM can perform single character translations.  You specify a character to translate, what character to translate it to; 
then RPM will replace all instances of the first character with the second. 
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RPM does not attempt to do multiple translations. For instance, let's say you want to change all A's to B's, and all B's to 
C's.  RPM will do exactly that; it will not change all A's to C's.  In other words, for each character in your print data, 
RPM performs exactly one translation, and then moves on to the next character in the data. 
 
The Character Translations dialog, described on page 34, allows you to define these translations. 

How To 
This section is a quick reference, dedicated to helping you use RPM quickly. We summarize a variety of topics that are 
explained in more detail elsewhere in this manual. 

Create a New Queue 
1. Choose a name for the queue. This name should be short; eight characters or less is preferable, but RPM 

supports longer names as well. We recommend that the name be less than 64 characters. 

2. Select “New Queue” from the “Queues” menu, or click the New Queue button  on the toolbar. For more 
information on the Create a Queue dialog, see page 36. 

3. Type the name for your new queue in the “Create a Queue” dialog, and click OK. 
4. RPM now presents the “Edit Queues” dialog, and shows the default settings for your new queue. You can 

change the queue type, printer, and other settings from this dialog. 
5. RPM requires you to select a printer for the queue because there is not always a default printer in Windows 

NT-based platforms.  In the “Edit Queues” dialog, press “Printer Setup”. 
 

  Note: If you need to change the operating characteristics of a queue, see the next topic. 

Change Queue Characteristics 
The easiest way to change queue characteristics is to double click on a queue in the Queue List window. RPM opens 
the “Edit Queues” dialog for that queue. 
You can also change some of the characteristics from the “Queues” menu.  If no queue is selected in the Queue List 
window, you will be presented with the “Select Queue” dialog discussed on page 54. Choose a queue and press the OK 
button. 

  Note: You can invoke the “Edit Queues” dialog from the “Queues” menu, Edit Queue  toolbar button or the 
queue type button in the Queue List window, which is represented by one of the following graphics depending on 
which queue type is in use. 
 
Button Representation 

 
Text Queue 

 
Pass-through Queue 

 
Filter Queue 

Delete a Queue 
If you have the Queue List window open:  

1. Highlight the queue in the Queue Status Window. 
2. Use the Delete key on the keyboard or select Delete from the Queues menu. See page 27 for more information 

on the Queues menu. 
3. RPM opens the Delete Queue dialog, highlighting the queue you selected. See page 36 for more information 

on the Delete Queues dialog. 
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4. If there are no active print jobs, or print requests still in transit, you may click the OK button to remove the 
queue. 

  Note: RPM will ask you for confirmation before you do this. RPM cannot recover a deleted queue, since it 
actually removes files and the registry keys. 
 
If you do not have the Queue List window open: 

1. Open the Delete Queue dialog as shown in 2 above. 
2. Select a queue in the list of queues. RPM shows you the status of the jobs in that queue, if any. 
3. If there are no active print jobs or print requests still in transit, you may click the OK button to remove the 

queue. 
  Note: After you click the OK button, RPM checks the status of jobs in the queue again so that it doesn't remove 

active jobs. 

Rename an Existing Queue 
When you rename a queue, you change the name by which the queue is known to print clients, and the name used in 
RPM. 
 
To rename a queue: 

• If the Queue List window is open, highlight the queue you wish to rename. 
• From the Queues menu, select Rename. 
• Select the queue in the Existing queue names list. 
• Type a new queue name in the field marked "New name for queue". 
• Click OK when you are done, or press the Enter key. 

 
  Note: RPM follows the same rules for queue names described in “Create a New Queue”.   There is more detail 

available for the Rename Queue dialog on page 53. 

Report Problems 
Our goal at Brooks Internet Software, Inc. is for you to receive the maximum benefit from our software products. 
Sometimes you may require assistance, even after you have reviewed the documentation. If this is the case, please 
contact us via email at support@brooksnet.com. 
 
If you are researching a feature and the documentation is unclear, we ask that you explain what it is you are looking for 
and how the documentation does not seem to help. If you have a suggestion on how it can be improved, please pass it 
along. Thanks in advance for your insight! 
 
If RPM does not seem to do what you expect, please tell us what you think it should do and why. We try to make the 
software easy to use. 
 
If RPM experiences a software failure, we ask that you do the following: 

1. Go to the Options menu and select Log. 
2. Set all the checkboxes on. 
3. Rerun your print job, or go through whatever steps are required to reproduce the problem 
4. Email the log file located in the RPM Logfiles folder along with a description of your problem to 

support@brooksnet.com 
5. Please be ready to send us further information if it is required to research the problem and find the correct 

solution. 

Determine What RPM is Doing 
The easiest way to determine what RPM is doing is to open the Queue List (see page 23) and Log (see page 25) 
windows, and watch them as RPM receives requests and prints. You can also see a greater level of detail on printing 
with the Print Status window (see page 25). 
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The highest level of detail is available in the Log window. By setting logging options (see below), you can see several 
levels of detail for network activity, commands and events related to queues, and for printing. 
 
One convenient feature in RPM is that it copies the contents of certain active windows to the clipboard by clicking on 

the Copy button  on the toolbar.  The Queue Status and Print Status windows both support the copy operation. 

Use Logging Options 
To see the “Log Options” dialog, choose “Log” from the “Options” menu (see page 27). For more information on what 
is logged, please see the “Log” window (see page 25). 
 
The Log Options dialog shows three categories of logging - network, print and queue logging. It also shows two levels 
of detail, on/off and high detail. 
 
When all logging is turned off, RPM logs minimal startup information including the date and time, and RPM version 
number. Also, any errors that RPM encounters are logged.  During the initial trial period, trial status messages are also 
logged. 
What happens when I turn on all logging? 
RPM runs a little slower due to the extra logging, and uses more disk space for the log.  Typically, the slow-down is 
unnoticeable by the user. 
Does this make RPM work better? Differently? 
Yes and no. "Yes" because if there is a problem, then the detailed log helps you our support staff to identify what is 
happening and either make a recommendation or fix the problem in RPM. "No" is also true, because RPM performs the 
same actions whether it is logging or not. 

Network logging 
When network logging is turned on, you will see: 

• Winsock status information when RPM starts 
• The clients IP address for each request 
• Warning messages when print clients violate security settings (see "LPD Security Dialog" on page 47) 
• Winsock errors 

When high detail for network logging is turned on, you will also see: 
• Status for incoming data 
• More detail on the LPD protocol 

Print logging 
When print logging is turned on, you will see: 

• Messages when queues are deleted or renamed 
• When queue cleanup takes place during RPM startup (see page 12) 
• Incoming queue requests from remote clients 

When high detail for print logging is turned on, you will see settings that RPM determines for you print job such as: 
• Font name and size 
• Line and page length 
• Physical margins and line wrap, etc. 

Queue logging 
When queue logging in high detail is turned on, you will see: 

• Messages at the start and end of print jobs 
• A message when a filter command is run 
• A message on which printer is used for a queue, whenever that information is accessed (for instance, during 

printer setup and font setup, as well as when printing) 
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Save Control File from Host 
This setting, if selected, tells RPM to save the control file, which comes as part of any LPR/LPD print job. It will be 
automatically removed when the print job is complete. Support personnel from Brooks Internet Software, Inc. may ask 
for a sample of the control file captured with this method. 
 
Clicking the Browse button allow you to select which folder, local or remote, that RPM will save the control file to.  
The RPM service account must have full access to any remote folder to save files to it. 

User Guide  
This section explains the windows, menus, and dialogs used by RPM. For quick help on performing a particular 
function in RPM, check the “How To” section that starts on page 19. 

Windows 

Main RPM window 
The main RPM window resembles a typical Windows application. Starting from the top, it contains a title bar, menus, 
toolbar, an area containing one or more smaller windows, and a status bar. The smaller windows may have scroll bars. 

Title Bar 

 
The title bar is located along the top of a window. It contains the name of the application and document. 
To move the window, drag the title bar.  Note that you can also move dialog boxes by dragging their title bars. 
A title bar may contain the following elements: 

• Application Control-menu button 
• Document Control-menu button 
• Maximize button 
• Minimize button 
• Name of the application 
• Title of the active window 
• Restore button 

Toolbar 

 
The toolbar is displayed across the top of the application window, below the menu bar. The toolbar provides quick 
mouse access to many tools used in RPM. Furthermore, RPM displays tool tips or "fly by help" when you leave the 
mouse cursor over a button on the toolbar for more than a few seconds. 
 
To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). 

Click To 

 
Create a new queue (see page 19) 

 
Edit an existing queue. RPM displays the Edit Queue dialog box, in 
which you can locate and edit the desired queue (see page 38) 

 
Copy the contents of the active window to the clipboard (see page 27) 

 
Show the Operator Job Control dialog to give fine control over a print job 
(see page 48) 
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Remove a job or queue (see page 19) 

 
Check all queues for jobs ready to be printed (see page 26) 

 
Display version and copyright information for your copy of RPM (see 
page 30) 

 
Invokes the Brooks License Manager (see page 31).  This allows users to 
view license status and license the software. 

 
Opens the help file to the contents page. 

 
Enable the user to get help on any button on the toolbar, menu item, 
window or dialog 

Status Bar 

 
The status bar is displayed at the bottom of the RPM window. To display or hide the status bar, use the Status Bar 
command in the View menu. 
 
The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus. 
This area similarly shows messages that describe the actions of button on the toolbars as you depress them, before 
releasing them. If after viewing the description of the button on the toolbar command you wish not to execute the 
command, then release the mouse button while the pointer is off the button on the toolbar. 
 
The right area of the status bar indicates the number of print jobs that Windows currently has queued. This number will 
increase every time RPM finishes a print job, or when another Windows application prints. Likewise, this number will 
decrease when the Windows Print Manager completes a print job.  You can also resize the RPM window on the right 
side of the status bar. 

Scroll Bars 
Scroll bars are displayed at the right and bottom edges of the window. The scroll boxes inside the scroll bars indicate 
your vertical and horizontal location in the document. You can use the mouse to scroll to other parts of the window. 

Queue List window 
The Queue List window is a split-pane window allowing users to access queue and job specific operations easily.  This 
window replaces the legacy “Queue Status” window from previous RPM versions. 

How To 

See Queues in Alphabetical Order 
Click the Queues column on the left window pane.  This sorts the queues in alphabetical order.  An up arrow  
indicates the column is sorted alphabetically in ascending order; a down arrow  indicates the row is sorted 
alphabetical in descending order. 

Delete all jobs in a queue 
Highlight the queue.  On the right pane, select the print job(s) you wish to delete.  Click the Delete keyboard button, 

choose Delete from the Jobs menu, or click the Delete Job  button on the toolbar. 

Select more than one job 
Highlight the queue to see a list of jobs currently in the queue.  On the right pane, select the print job(s) you wish to 
delete, hold, or unhold.  Press Ctrl+A to select all print jobs or use the Ctrl+Click with the left mouse button to select 
more than one. 
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Queue List Left Pane 
On the left pane, each queue is listed by name, how many print jobs have been received since the user-interface was 
opened, and the number of print jobs currently in the queue, such as print jobs that are held or waiting for another task 
to finish. 

Queue List Right Pane 
The right pane is also split into two sections.  The top of the pane shows the selected queue name, the status, and last 
operation performed on each queue.  It also provides access to easily open the “Edit Queues” dialog (page 38), the 
“Print Setup” dialog, and modify the queue states (page 13).  
 
The lower portion of the pane includes a scrollable list of print jobs in the currently selected queue.  The information is 
displayed in columns for ease of reading, with one job per line. 
 
From left to right the columns are: 

Column Description 
Job #71 A sequence number kept internally by RPM for each queue 
User ID The username sent in the control file from the client 
Host name The hostname of the client provided by TCP/IP 
Job title The title of the document provided in the control file by the client 
Activity Can be either Xfer, Print, Wait or Hold 
Detail Display will show Control, Data, Start, Banner or Page n 
Percent Can be anywhere from zero to 100% or Done 
Date The date and time of the data file or the start of printing 

Queue Status window 
The Queue Status window is a scrolling list that displays the queue names (see page 71), their current states (page 13), 
last command received for the queue, and any jobs. RPM updates this display dynamically, without user intervention. 
 
The title of the Queue Status window includes the number of queues currently defined in RPM.  Selecting a queue in 
this window can accelerate virtually every function in RPM that uses a queue name. 
 

  Note: if you double click in the Queue Status window, RPM opens the Edit Queues dialog and displays the queue 
you selected. 
 
You can copy the entire contents of the Queue Status window to the clipboard by selecting Copy from the Edit menu 

(see page 27), or clicking the Copy button  on the toolbar. 
 
Following is a sample queue: 

Queue lp: Enabled, Processing, Not Holding 
Status: Printer ‘HP LaserJet 5’ is defined. 

 
The first line contains the text "Queue" and the name of the queue, followed by the current states.  The second line is 
the status of the queue; it contains the text "Status:” followed by the command. Whenever RPM receives a request for a 
queue, this line is updated. 
 
Following the command could be one or more jobs, if any jobs are present in the queue. The information is displayed in 
columns for ease of reading, with one job per line. 
From left to right the columns are: 

• Sequence number (see the Glossary, which starts on page 71) 
• User ID 
• Host name 
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• Job title 
• Activity: You will see either "Xfer", "Print", or "Wait". 
• Detail: Display will show "Control" when receiving the control file, "Data" when receiving the data file, 

"Start" when beginning to print, "Banner" when printing the banner, or "Page n" when printing page 'n'. 
• Percent, from zero to 100% or "Done" 
• Date: The date and time of the data file or the start of printing 

Log window 
The Log window displays messages logged by RPM. This topic describes the window itself, as well as the log 
messages.  The topic "Use Logging Options" on page 21 describes how to control what is logged. 
 
The Log window is a scrollable list. One message appears on each line of the window.  Each message has an event 
number, time-stamp, source of the message, application sending the message, and the message text. 
 
Note that the title of the log window is a filename containing the current date. This file is stored in a “logfiles” folder 
located directly beneath the RPM root folder.  The file is updated whenever a message is logged and the display 
window updates automatically.  Due to Unicode restrictions, the contents of the log window cannot be copied to the 
clipboard. 
 
The Log window also has the ability to change between four different views typically provided in a 
Windows application: small icons, large icons, list, or details.  To change between the views, right-
click anywhere in the Log window.  The menu shown will appear.  This menu also has the ability to 
open a previous RPM log file, re-open the current file, save the log file currently being viewed with a 
new name, and to refresh the log file. 
 
There are four types of severity, or categories, of log messages: 

• Information, which merely provides diagnostic information. 
• Success, which indicates when an action completes successfully. 
• Warning, denoting a situation requiring your attention. 
• Error, which denotes a serious situation. 

 
The following graphic is a segment of an actual log file: 

 
Note the timestamp and the startup information. 
 
A list of all messages that might appear in the Log can be found on page 64.  Many of the messages are self-
explanatory, and some may require assistance from your local system administrator or networking staff. 

Print Status window 
The Print Status shows a higher level of detail on print jobs than you can find in the Queue Status window, including: 

• The queue name 
• The sequence number (next to the text "Item") 
• The user ID 
• The host name 
• The title 
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• The printer or the path to the filter program 
• Detail, which includes the current page number, or the banner 
• Percent 
• Date, the date and time at the start of the print job 

 
You can copy the entire contents of the Print Status window to the clipboard by selecting Copy from the Edit menu, or 

clicking the Copy  toolbar button. 

Menus 
File Menu 
The File menu offers the following commands: 
New queue Creates a new queue. 
Print Jobs Checks each job to see if it is ready to print. 
Exit Exits RPM. 

New Queue  
Use this command to create a new queue in RPM. 
Shortcuts 

Toolbar:  
Keys: CTRL+N 

Print Jobs 
Use this command to print any ready jobs. Normally RPM does this automatically; if you have made changes to 
existing jobs that RPM is not aware of, then use this function. 
Shortcuts 

Toolbar:  
Keys: CTRL+P 

Exit 
Use this command to end your RPM session.  You can also use the Close command on the RPM Control menu.  RPM 
closes the UI, but continues accepting and printing jobs. 
Shortcuts 

Mouse: Double-click the RPM Control menu button. 
 Click the Close  button on the right side of the RPM title bar. 
Keys: ALT+F4 

 
For more information, see Exiting RPM on page 12. 

Edit menu 
The Edit menu offers the following commands: 
Copy Copies the contents of the active RPM window to the clipboard. 
Delete Deletes a job or queue from your RPM configuration 
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Copy  
Use the Copy command to copy the contents of the active RPM window to the Windows Clipboard. 
Copying data to the clipboard replaces the contents previously stored there. 
Shortcuts 

Toolbar:  
Keys: CTRL+C 

Delete  
Use this command to delete print jobs. This operation can also be done from the “Operator Job Control” dialog, 
discussed on page 48.  This button does not delete queues; to delete queues, see the topic “Delete a Queue” on page 19. 
Shortcuts 

Toolbar:  
Keys: Delete 

Queues Menu 
The Queues menu offers the following commands: 
New queue Add a queue to your RPM configuration (see page 19) 
Edit queues Change the settings for a queue (see page 19) 
Styles Invokes the Styles menu (see below) 
Operator Operator Job Control interface for selected job (see page 48) 
Delete Delete a queue (see page 19) 
Rename Change the name of a queue (see page 19) 
Enable/Disable Enable or disable a queue (see page 13) 
Resume/Suspend Resume or suspend processing for a queue (see page 14) 
Holding Specifies whether or not a queue or job is holding (see page 14) 
 
The Styles menu offers the following commands: 
Manage Styles Create styles and use queue settings in style (see page 56) 
Use Styles Copy style settings to a queue (see page 63) 
 

  Note: These options are discussed further.  Please consult the listed pages. 

Jobs Menu  
The Jobs menu offers the following commands: 
Open Access the Edit Queues dialog (see page 38) 
Holding Hold/Unhold currently selected job. A checkmark indicates the current job status. 
Delete Delete currently selected job without processing it. 
 

  Note: A job must be selected before the menu items are available. 

Options Menu  
The Options menu offers the following commands: 
Settings Modify miscellaneous settings for RPM (see page 54) 
Log Modify logging options, levels of detail (see page 46) 
Host Access Manage settings to allow and restrict access from other computers (see page 15) 
Translations Invokes the Translations menu (see below) 
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LPD Security Modify LPD protocol security settings for RPM (see page 47) 
Protocols Manage protocol ports and settings (see page 55) 
Printer Limits Review or change printer limits 
  
The Translations menu offers the following commands: 
Tables Create named translation tables (see page 61) 
Contents Edit the contents of a translation table (see page 34) 
 

  Note: These options are discussed further.  Consult the listed pages. 

View menu 
The View menu offers the following commands: 
Toolbar Shows or hides the toolbar. 
Status Bar Shows or hides the status bar. 
Workbook Control whether RPM shows pages as a workbook. 
Queue status Shows or hides the Queue status window. 
Print status Shows or hides the Print status window. 
Log Shows or hides the Log window. 

Toolbar 
Use this command to display and hide the Toolbar, which includes buttons for some of the most common commands in 
RPM. A check mark appears next to the menu item when the Toolbar is displayed. 
See page 22 for help on using the toolbar. 

Status Bar  
Use this command to display and hide the Status Bar. A check mark appears next to the menu item when the Status Bar 
is displayed. 
See page 23 for help on using the status bar. 

Workbook 
RPM arranges windows as if they were separate pages, with a row of tabs at the bottom of the RPM window. This 
design resembles a workbook. 
You can return RPM to the traditional multiple window arrangement by selecting View/Workbook, then select it again 
to return to the workbook. 

Queue Status 
Use this command to display and hide the Queue status window, which shows the names and status of the queues 
currently defined in RPM, as well as status of any jobs. A check mark appears next to the menu item when the Queue 
status window is displayed. 
See page 14 for help on using the Queue status window. 

Print Status  
Use this command to display and hide the Print status window, which shows detailed status information for the current 
or most recent print job. A check mark appears next to the menu item when the Print status window is displayed. 
See page 25 for help on using the Print status window. 

Log  
Use this command to display and hide the Log window. A check mark appears next to the menu item when the Log 
window is displayed. 
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See page 25 for help on using the Log window. 

Window menu 
The Window menu offers the following commands, which enable you to arrange multiple views of multiple documents 
in the application window: 
Cascade Arranges windows in an overlapped fashion. 
Tile Arranges windows in non-overlapped tiles. 
Arrange Icons Arranges icons of closed windows. 
Window 1, 2, ... Goes to specified window. 

Cascade 
Use the Cascade command to arrange multiple opened windows in an overlapped fashion. 

Tile 
Use this command to arrange multiple opened windows in a non-overlapped fashion. 

Arrange Icons 
Use this command to arrange the icons for minimized windows at the bottom of the main window. If there is an open 
window at the bottom of the main window, then some or all of the icons may not be visible because they will be 
underneath this window. 

Window 1, 2... 
RPM displays a list of currently open windows at the bottom of the Window menu. A check mark appears in front of 
the document name of the active window. Choose an item from this list to make its window active. 

Help menu 
The Help menu offers the following commands, which provide you assistance with this application:  
Help Topics Offers you an index to topics on which you can get help 
Using Help Provides general instructions on using help 
License... Opens the Brooks License Manager (see page 31) 
About RPM Displays the exact version of RPM 

Help Topics 
Use this command to display the opening screen of Help. You can access instructions for using RPM and various types 
of reference information from the opening screen.  
Once you open Help, you can click the Contents button whenever you want to return to the opening screen. 

Using Help  
Use this command for instructions about using Help. 

License... 
When you select “License…” from the help menu, RPM runs the “Brooks License Manager” program (LicMgr.exe). 
This allows you to check the trial status, register RPM, contact the publisher and/or reseller via their website or sending 
e-mail, and print your RPM license if, in fact, RPM is licensed.   For more information on the Brooks License Manager, 
see page 31. 
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About RPM 
This command displays the “About” dialog. See page 34 for more information.  

Control menu 
The “Control” menu is located at the upper left corner of the RPM main window, Queue 
Status, Log, or Print Status window, and some of the other dialog boxes. 
 
The Control menu offers some or all of the following commands: 

Command Action 
Restore Returns a window to an earlier size and position, after minimizing or maximizing 
Move Move the active window or dialog box 
Size Resize the active window 
Minimize Reduces the current window to an icon 
Maximize Increases the size of the current window to fill the display 
Close Closes the active window or dialog box 
Next Makes the next window active 

Restore 
Use this command to return the active window to its size and position before you chose the Maximize or Minimize 
command. 

Move  
Use this command to display a four-headed arrow so you can move the active window or dialog box with the arrow 
keys. 
 

  Note:  This command is unavailable if you maximize the window.  You can also move the window by dragging 
the Title Bar. 
Shortcut 

Mouse: Drag the title bar at the top of the window 

Size 
Use this command to display a four-headed arrow so you can size the active window with the arrow keys. 
 
After the pointer changes to the four-headed arrow: 

• Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the border you 
want to move 

• Press a DIRECTION key to move the border 
• Press ENTER when the window is the size you want. 
  Note:  This command is unavailable if you maximize the window. 

Shortcut 
Mouse: Drag the size bars at the corners or edges of the window. 

Minimize  
Use this command to reduce the RPM window to an icon. 
Shortcuts 

Mouse: Click the minimize button on the title bar. 
Keys: ALT+F9 
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Maximize 
Use this command to enlarge the active window to fill the available space. 
Shortcuts 

Mouse: Click the maximize button on the title bar; or double-click the title bar. 
Keys: CTRL+F10 enlarges a document window. 

Close  
Use the Close command to close the active window or dialog box. 
Double-clicking a Control-menu box is the same as choosing the Close command. 
Shortcuts 

Mouse: Click the close button on the title bar. 
Keys:  CTRL+F4 closes a window within RPM 

  ALT+F4 exits RPM or closes a dialog box 

Next 
Use the Next command to toggle between open windows in RPM.   Possible open windows could be the Queue Status, 
Log, and Print Status windows. 
Shortcuts 

Keys: CTRL+F6 displays the next open window. 

Brooks License Manager 
The Brooks License Manager provides license management functions for software developed by Brooks Internet 
Software, Inc.  The license management software is provided with each application obtained from Brooks.  When the 
software is installed, a 21-day trial period is initialized.  Accompanying each purchase, instructions on unlocking the 
software are provided.  The Brooks License Manager is used for monitoring and unlocking the application. 
 
The Brooks License Manager software is used to perform the following functions: 
1. During a trial period, users can determine the number of days remaining before the trial period ends. 
2. View the installed modules, if any, and provide a way to license them. 
3. After the software is licensed, users may view and print the license information. 
4. Users can also view information about Brooks or the reseller, which includes contact information. 
5. Version number and copyright information for the license manager can be viewed in the About tab. 

License Status Tab 
During the trial period, this tab shows information about the license including the product, product version, serial 
number, and number of days remaining until the trial license expires. 
 
After the application is licensed through the License Wizard, information about the license is shown.  This includes the 
registered username and company, product and version, licensed date, when the support contract expires, and the serial 
number. 

Print License  
Pressing this button allows license manager to print the license information to a printer.  License manager can print to 
any available Windows printer, just as other applications do.  When pressing this button, the standard Print Setup 
dialog is displayed allowing the user to select the printer and change the properties. 
 

  Note: This button is available only after the software has been unlocked. 
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Copy 
This button is used to copy the license information to the clipboard.  Users can then paste the information into another 
application for storing license information on disk, rather than printing it. 
 

  Note: This button is available only after the software has been unlocked. 

License 
Pressing this button invokes the Application Unlock Wizard, which allows the license to be updated.  After the initial 
licensing, this is used to update the support expiration date or change the registered username. 

Module Status Tab 
This tab contains a grid that displays modules that have been installed in easy-to-read columns.  This list shows the 
modules, the license status of the module, the quantity if applicable and a description of the module. 

License Module 
This button allows the user to unlock or update modules that are currently installed.  The Application Unlock Wizard 
must be completed prior to unlocking installed modules. 

Publisher Tab 
This tab provides information about the publisher of the software.  Included here is the address, city, state, postal code, 
and country.  Phone and fax numbers are listed and links to contact the publisher via email or the website are also 
provided. 

Reseller Tab 
This tab provides information about the reseller of the software.  Included here is the address, city, state, postal code, 
and country.  Phone and fax numbers are listed and links to contact the publisher via email or the website are also 
provided if available. 
 

  Note: This tab is available when downloading the software from some resellers. 

About Tab 
This tab provides information about the Brooks License Manager.  Version and copyright information are displayed 
and links are provided to email and visit the publisher’s website. 

License Wizard 
The Application Unlock Wizard guides you through the steps of unlocking or updating the software license.  Each step 
is simple to follow; users provide information and the software is unlocked if all information is entered correctly. 
 
This wizard is accessed from the License Status tab of the Brooks License Manager application. 

Collecting Information 
This step is where you enter the user and company that the software is licensed to.  A unique username is required for 
each license.  If the username is not unique, the web unlock function will notify you. 

Determining Unlock Method 
The second step in unlocking the software is to determine whether to unlock using an unlock key or an order number 
and authentication code. 
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  Note: A connection to the Internet is required when unlocking using the order number and authentication code.  

Entering Support Expiration 
This step is required only when unlocking using an unlock key.  This date is required to know when the support 
contract expires.  This date is typically one year to the date of purchase; it is shown on the invoice or can be obtained 
from Brooks.  If the support date is entered incorrectly, the unlock request will be unsuccessful.  This date is 
automatically transmitted when unlocking using an order number and authentication code. 

Edit… 
Pressing this button displays a calendar which allows you to select the correct date that support expires.  If you are 
unsure of the correct date, consult your sales receipt/invoice for the purchase date. 

Complete the Unlock Process 
This step is the final step in unlocking the software.  It is different depending on options chosen in previous steps, most 
notably the step “Determining Unlock Method”. 

Quantity 
Certain modules may require that a quantity be unlocked, such as the RPM Printers module.  If you have purchased an 
updated number of printers, enter the quantity here. 

Unlock using an order number and authentication code 
Enter the order number and authentication code in the corresponding entry.  The sales receipt or invoice number is 
referred to as the order number.  There are also 3 choices corresponding to the automated way you prefer to unlock the 
software. 
 
When you select Web Unlock, License Manager will attempt to connect directly to our web server and transmit the 
encrypted license information to our server. 
 
When you select either of the email options, your default mail client is opened and populated with the information 
needed by Brooks to provide and unlock key.  Verify that the mail format is plain text so the server can correctly 
provide an unlock key.  This process is automated and can be used outside normal business hours.  

Unlock using an unlock key 
Enter the appropriate unlock key and the software will be unlocked.  This key is provided by Brooks either 
automatically from this wizard or by contacting Brooks directly.  Contact information is provided in the main License 
Manager window. 

Web Unlock 
Web Unlock requires the license manager to connect directly to our web server over the Internet.  License manager 
provides the ability to specify alternate proxy server settings.  The first time license manager is accessed, it reads the 
proxy server settings directly from Internet Explorer settings and populates the fields with this configuration. 
 
Users have the ability to specify alternate proxy server settings if Internet Explorer is not installed or not currently 
configured. 
 
Use HTTP proxy simply tells license manager that a proxy server is in use.  The Address and Port entries then become 
available and you can configure proxy settings here. 
 
Reset causes license manager to synchronize with the current Internet Explorer proxy server settings, if available. 
 

  Note: Proxy Server settings can be obtained from your network administrator. 
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Dialogs  
The following pages describe each dialog RPM provides and what each dialog is for. In most cases we include 
shortcuts that answer "how to" questions.  

About dialog 
The About dialog is accessed by selecting “About RPM…” 
from the “Help” menu or by clicking on the “About” button 
on the toolbar.  Use this command to display the copyright 
notice and version number of RPM. 
 
The “About” dialog box shows the user name and serial 
number for this copy of RPM. Both are contained in read-
only edit controls, which allow you to select and copy them 
to the Windows clipboard.  You will also find the contact 
information such as the email address for technical support 
and phone and fax numbers for Brooks Internet Software, 
Inc. 
 

  Note: Before submitting a problem report, please see 
“Reporting Problems” on page 20. 

Character Translations dialog 
The Character Translations dialog allows you to create and edit character translations, for one translation table at a 
time. Please see page 17 for more information on RPM data translations 

Shortcuts 

Translating Typable Characters 
1. In the “Translate from”, enter an ASCII character you wish to 

translate.  At this point, the cursor moves automatically to the 
“Translate to” box. 

2. Enter an ASCII character here.  The table is updated automatically.  
You can now enter another typable character. 

 
RPM automatically adds the translation to the table and moves the cursor back 
to “Translate from”.  
 

Translating Characters Using Hexadecimal Codes 
In the “Translate from”, enter a 2-digit hexadecimal number for the character 
you wish to translate in the appropriate field.  The cursor will be automatically moved to the “Translate to” field. 
Now, enter the 2-digit hexadecimal number that you want the character to be.  When finished the cursor moves back to 
the “Translate from” box. 
 
RPM automatically adds the translation to the table and moves the cursor back to the “Translate from” field.   We have 
included an ASCII table on page 72 for your convenience. 
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  Note: RPM attempts to make the character entry as simple as possible.  You simply need to add the appropriate 
information to the "from" and "to" fields. RPM inserts a new translation, or updates an existing translation, 
automatically. It also moves between the fields on its own, after typing two characters each. 

Changing a Translation 
Do one of the following: 

1. Re-enter the translation as described above using the same "from" character and the desired "to" character. 
2. Select the translation from the list and enter a new "to" character. 

Removing a Translation 
Select the translation in the From/To list, and then click the button labeled “Remove”. 

Translation tables 
This drop-down list contains the names of the currently defined translation tables. The contents of the selected table are 
shown in the “From/To” list. 
 
You can edit another translation table by selecting it in the Translation tables list. If you have made any changes to the 
current table, RPM will save those changes for you. 

From/To 
The “From/To” list contains the current translations. RPM attempts to show each character as a printable value (e.g., 
'a'), or symbolic value (e.g., 'ESC'); otherwise it will use the hexadecimal value. 
 
Select a translation in this list to edit or remove it. 

Translate from 
The Translate from area of the dialog contains two fields, one for entering an ASCII character, the other for entering 
two hexadecimal characters. 
 
If you put the cursor in the ASCII field and enter a character, RPM accepts that character and moves the cursor to the 
ASCII field in the “Translate to” area.  If you put the cursor in the hexadecimal field and enter two hex characters, 
RPM accepts them as a single character, and moves the cursor to the hexadecimal field in the “Translate to” area.  

Translate to 
The “Translate to” area of the dialog contains two fields, one for entering an ASCII character, the other for entering 
two hexadecimal characters. 
 
If you put the cursor in the ASCII field and enter a character, RPM accepts that character and adds or updates the 
translation.  If you put the cursor in the hexadecimal field and enter two hex characters, RPM accepts that as a single 
character, and adds or updates the translation 
 

  Note: If you enter anything but hexadecimal characters in the Translate from or to, that is '0' through '9' and 'A' 
through 'F', RPM refuses the character. 
 

Shortcuts 
These buttons are shortcuts to entering a tab, escape character, carriage return, line feed or form feed.  
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If the cursor is in the “Translate from” area, the appropriate hex codes are inserted and the cursor is automatically 
moved to the “Translate to” area.  If the cursor is in the “Translate to” area, the appropriate translation is added to the 
list. 

Remove 
Click this button to remove the currently selected translation.  This button will be unavailable if no translation is 
highlighted in the list. 
 

Create a Queue dialog 
Use the New Queue dialog to create queues. After you have entered the queue 
name and clicked the OK button, RPM opens the Edit Queues dialog (see 
page 38) so that you can set queue characteristics. 

New queue name 
Enter the name you wish to use for a queue. RPM allows queue names to 
contain alphabetic characters 'A' through 'Z' (upper and lower case), digits '0' 
through '9', dash ('-') and underscore ('_'). White space characters such as 
space or tab are not allowed in a queue name. 

Existing queue names 
RPM displays the names of existing queues. As you type, RPM uses your input to search the existing queue names. If it 
finds a match, it selects the queue from this list. 
 
For instance, if you type the letter 'l' then the third queue in our figure, 'lp', would have been highlighted. RPM does this 
to help the user avoid entering a name for a queue that is already in use. 
 
Continuing this example, if you typed the letter 'l' but followed it with a letter other than 'p', RPM would realize that 
you are not going to use the name 'lp' and will deselect that queue in the existing queues list. 

OK/Cancel 
When you click OK, RPM checks to make sure the queue name you entered is not already used by another queue.  If 
not, RPM creates the new queue and displays the Edit Queue dialog.  If it is already used, you get an error and the 
queue is not created.  If you press Cancel, no queue will be created and the Create a Queue dialog will be closed. 

Delete Queue dialog 
The Delete Queue dialog allows you to remove a queue, all the jobs in the 
queue and the queue configuration information. 
 

  Note: If any of the jobs in the queue are active, that is printing or being 
transferred, RPM will not allow you to delete the queue. 
 
Please see "Delete a queue" on page 19 for more information. 
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Edit Bytes dialog 
This dialog will assist you in creating a custom byte sequence. RPM uses this dialog to prepare bytes to insert before a 
print job, append to a print job, and as a page separator. 

How To 

Enter a Typable Character 
In the Current bytes field RPM will display a position marker that looks 
like a plus(+) sign over a minus(-) sign. The position marker is shown in 
the dialog. 
Move the cursor to the field labeled “Enter an ASCII character”, and type 
a character. The character you type appears where the marker was, and 
the marker moves right. 

Enter a Character Using Hexadecimal Codes 
Locate the position marker in the “Current bytes” field. Now move the 
cursor to the field labeled Enter two hexadecimal characters and type 
your 2-digit hexadecimal number. The position marker moves right and 
character appears where it was. 

Move the Insert Point Left or Right 
The Left and Right buttons move the position marker left and right, respectively. 

Remove a Character 
Move the position marker to the left of the character you wish to delete. Click the Del button. The position marker 
keeps its position, the deleted character disappears, and the remaining characters to the right of the deleted character 
move left. 

Enter Special Characters 
Position the position marker where you want the character to go, then click the Escape, CR, LF, or FF button.  These 
buttons are for the Escape key on the keyboard, a carriage return (Enter on the keyboard), a line feed, which tells the 
printer to start on the next line, and a form feed, which tells the printer to start printing on the next page. 

Alphanumeric & Hexadecimal 
These settings control whether RPM tries to show characters by their symbolic value or the hexadecimal value. 

Current bytes 
This field shows you the current byte sequence in hexadecimal notation. RPM supplies a position marker that should 
resemble an arrow pointing down to a line. When RPM inserts a byte into the current bytes, it places it to the left of the 
position marker. 

  Note: You cannot change the bytes with this field; it is for display purposes only. 

Position & Length 
The position field shows the location of the position marker, after which the next byte will be inserted. The length field 
shows the length in bytes of the current bytes. 
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Left, Right, & Del 
The Left button moves the position marker one byte to the left. If the position marker is at the beginning of the current 
bytes, the Left button has no effect. 
 
The Right button moves the position marker one byte to the Right. If the position marker is at the end of the current 
bytes, the Right button has no effect. 
 
The Del button deletes the byte to the right of the position marker. If the position marker is at the end of the current 
bytes, the Del button has no effect. 

Enter an ASCII character 
Enter any character that you can normally type into a text field. RPM empties this field, inserts the byte in the current 
byte just after the position marker, displays it in the Current Bytes field, and adds one to the position and length fields. 

Enter two hexadecimal characters 
Use this field to enter bytes. The characters must be hexadecimal, either digits 0 through 9 or letters A through F. You 
can enter lower case a through f if you wish, and RPM will translate. 
 
If you enter anything else, RPM will display a dialog showing you which characters to enter, and will remove any 
characters in this field. The current bytes are unaffected. 
 
Once you have entered two hexadecimal bytes, RPM empties this field, inserts the byte in the current byte just after the 
position marker, displays it in the Current Bytes field, and adds one to the position and length fields. 

Escape/CR/LF/FF 
RPM inserts an Escape, carriage return, line feed or form feed character as if you had entered the bytes manually. 

Edit Queues dialog 
Use the Edit Queue dialog to change queue settings.  Several other dialogs work with this, including Print Data options 
(see page 49), Printer Setup (page 53), Text Setup (page 58), Pass-through Setup (page 49), and Filter Setup (page 40). 
Note: if you open any of the above dialogs and make changes, those changes are saved when you close that dialog, not 
when you close the Edit Queues dialog. 

How to 

Select a Printer 
Click the “Printer Setup” button. This presents the standard Windows printer 
dialog. Select a printer and any other options; click OK. RPM saves the printer 
information and optional settings for all future printing to the selected queue. 
 

  Note: Printer settings such as orientation and paper size are available in 
text type queues only.  For a description of queue types, see page 13. 

Change Queue Settings 
Select a queue type from the Queue types group. Then click the “Queue Setup” 
button. 

Get Advanced Features 
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If you would like more advanced features of RPM such as inserting bytes and character translations, click the “Print 
Data Options” button. 

Select a queue 
This drop-down list contains the names of all configured queues. If RPM can make an intelligent guess about which 
queue you want to edit, it will display it here, otherwise, select it from the list. 
 
Use the drop-down list to select a different queue to edit. If you edit a queue with this dialog, and then select another 
queue with this drop-down list, all settings for the first queue are automatically saved. 

Queue types 
RPM supports several kinds of queues: Text queues, Pass-through queues, and Filter queues. Please see page 13 for a 
discussion of queue types. 

Queue Setup 
Click the Queue setup button to get a setup dialog appropriate for the current queue type. RPM combines the Text 
Setup, Raw Setup, and Filter Setup button from previous versions into this button. 

Print Data Options 
This button invokes the Print Data Options dialog. 

Printer Setup 
RPM offers the standard Windows Print Setup dialog to configure settings. RPM supports any options available to the 
printer and print driver. RPM stores these options; whenever a print job is sent to this queue these options are used.   
This button is disabled when a filter type queue is selected. 
 
For instance, one queue can be configured to print landscape.  All print jobs sent to this queue will print landscape, 
even if the computer is restarted. 
 

  Note: Printer settings such as orientation and paper size are available in text type queues only.  For a description 
of queue types, see page 13. 

Printer 
The name of the Windows printer is shown here with raw and text type queues.  When a queue is first created, it will 
use the Windows default printer. Use the Printer Setup button to select a different printer, or change the queue type to 
Filter and use the Queue Setup dialog to select a filter program. 

Queue States 

Enable this queue to receive requests 
Queues can be enabled or disabled. Please see Enable/Disable on page 13 for more information. 

Suspend processing on queue 
Queues can be suspended or resumed. See Resume/Suspend on page 14 for more information. 
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Hold print jobs, operator controlled 
Jobs can be held until manually released. If the queue is set to hold, then all jobs sent to it will be held, and vice versa. 
See Operator Job Control on page 48 for more information. 

Filter Setup dialog 
Filename tab 

Use long filename 
Select this option if you want RPM to use the default filename.  The 
filename begins with ‘dfA,’ followed by a sequence number and the 
sending side’s hostname.  

Use short filename 
Select this option to use short filenames when saving to disk or 
opening the data in another application.  Short filenames use the 
DOS 8.3 naming convention where you have an 8-letter filename 
and a 3-letter extension. 

Use job sequence number 
Setting this option allows you to create your own filename for the filter.  An example of a customized filename is 
df0001.txt.  In this example, the filter filename is "df", there are 4 pad digits and the file extension is txt. 

Use filename from remote host 
The filename from the remote host may be used to identify the file.  This name is sent obtained from the control file. 

Append to file 
By selecting this option, you can append incoming data to a file.  Click the browse button to select the file to append to.  
If the file does not already exist, RPM will create a new file. 

Use print job data 
This allows you to use other control file information to formulate the filename.  You can use such things as user, 
remote host, date and time, etc. for the name of the file.  See “Use Job Data dialog” on page 62 for more information. 

File Path tab 

Directory path to copy files to 
RPM gives you the option to copy the data file to another directory. 
We recommend that you do this because, after RPM processes your 
print job, it will then delete the print job, including the data file.  Use 
the browse button to locate a new directory. 

Use file extension 
Your filter program may expect a certain filename extension.  To use 
the file extension, you need to put a check in this box and specify the 
extension. 
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  Note: RPM is looking for the characters that follow the period ("."), and will remove the period and anything that 
comes before it. For instance, *.txt becomes txt. 

Overwrite temporary files 
After a directory path is specified, you may allow RPM to overwrite files with print data when this option is selected.  
This option completely removes the previous file when doing a copy and there is no undo option. 
 

  Note: This option is not recommended for use in the RPM spool folder or key operating system folders such as the 
system root, typically C:\Windows or any of the subfolders located directly beneath this folder. 

Execute tab 
How do I get RPM to leave the data file in a directory on my 
computer, without doing anything else to it? 

1. Specify an extension for the file, e.g. TXT or PS. 
2. Specify an existing directory to copy the files to. 
3. Leave the command line empty. 

Program command line, with arguments 
Click the “Browse” button to locate the program you wish to use to 
open the file.  If you do not specify the full path for the program, make 
sure it is in the PATH or RPM cannot execute it. 
 
To specify the right command line arguments, first consult the 
documentation for your filter program. 
How RPM handles the filename:  

1. To make RPM insert the filename inside a command line, use the string "%s". For example, this command 
line:  “C:\WINDOWS\NOTEPAD.EXE /p %s” will cause the Windows "notepad" utility to open the file, print 
it, and exit. 

2. Let's assume that RPM copies the data file from your print request to the path 
“C:\WINDOWS\TEMP\DF12.TXT". RPM will create the following command line for Windows:  
C:\WINDOWS\NOTEPAD.EXE /p C:\WINDOWS\TEMP\DF12.TXT.  RPM will then execute this command 
line, and will log any problems executing this command. 

If the program command line does not contain "%s", then RPM appends a space and the path of the data file to the 
command line before executing the filter program. 
Adapting our earlier example, let's say that the program command line resembles the following: 
C:\WINDOWS\NOTEPAD.EXE 
Let's again assume the data file path "C:\WINDOWS\TEMP\DF12.TXT". RPM will create the following command line 
for Windows: C:\WINDOWS\NOTEPAD.EXE C:\WINDOWS\TEMP\DF12.TXT 
As before, RPM will then execute this command line, and will log any problems executing this command. 

Show filter 
When a Windows program is executed, typically it is shown on the screen. Many users find it distracting to have 
application windows suddenly appear on the screen. 
RPM gives you the option to "show" the filter program as an icon, a normal sized window, a full screen window 
(maximized), or not to show it at all (hidden). 

Delete temp files when program finishes 
If RPM copies the data file to another location, it will optionally remove the new file after the filter program exits. 
We recommend that you leave this setting on, unless you have a need to keep these files. Be sure to check your disk 
space often to avoid running out of room. RPM cannot be responsible for the disk filling up if you don't allow it to 
delete files. 
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  Note: When RPM exits, it attempts to check the status of the filter program. If the filter program is still running at 
that time, RPM will not delete the temp file, and will not check later. You may need to perform your own temp file 
checks from time to time. 

Run one filter program at a time 
We recommend that you run one filter program at a time. This will help ensure that your PC does not become 
overloaded if a number of filter jobs are sent at once. 

  Note: If this setting is off, then RPM will not be able to delete temp files, because it will not know if the filter 
program is finished. 

Translate LF TO CR/LF 
Your system may not use LF to return to the next line.  If this is the case, you need to mark this selection to change all 
Line Feeds to Carriage Return/Line Feeds.  That way, your characters will not be overwritten, but written on the 
following line. 
 

  Note: Because RPM runs as a Windows service, applications will not appear to the user unless the service is 
running as the local SYSTEM account.  Also, RPM cannot run DOS commands such as ‘cd’ or ‘dir,’ only executable 
programs, usually denoted by a bat, exe, or com extension. 

Font dialog 
Use the “Font” dialog to select a font for your print jobs. This 
is the standard Windows font dialog for the selected printer. 
 

  Note: Only the fonts that your print driver supports will 
be displayed in this dialog.  For instance, your printer may 
support the ‘lineprinter’ font, but not all print drivers allow 
access to this font. 

Font 
This list shows the fonts that are currently available.  If a font 
is not listed, the print driver does not support it. 
 
Each font in this dialog is represented by an icon.  Each icon is 
explained in the following table. 

  
These are true type and open type fonts that are rendered from line and curve commands.  These fonts scale 
well and can be easily stretched both horizontally and vertically.  These fonts are clean, even when the size is 
very large. 

  
These are raster or vector fonts that are rendered using bitmaps or drawn in an arrangement of line segments.  
Many of these types of fonts are provided only for legacy applications and output devices.  As these fonts get 
larger, they may appear with jagged lines and look worse than true type fonts. 

Font Style 
You can select that the font be regular, italicized, bold, or bold and italicized. 

Size 
This option allows you to choose what size font to print.  RPM may also ignore the font size when scaling the font to a 
particular width and height, such as when Use lines per inch is selected in the Text Setup dialog. 
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Sample 
The sample shows what the font settings you have selected looks like as it is printed, including the size and style 
selected. 

Script 
The script lists the available language scripts for your chosen font.  You will not necessarily be able to select the same 
script with a different font.  If you wish to use a particular script, then the font you select must be able to support it. 
 

  Note: RPM stores the font information for each queue; each time you print, RPM will use the font you selected for 
that queue.  The font size may also be dependent on other queue settings. 

Host Access dialog 
During initial configuration or troubleshooting, host access checking should be disabled which allows all print clients 
access to RPM.  Only after RPM has been configured properly should host access checking be enabled.  Host access 
checking restricts printing, it does not enable it. 

Host Rules Tab 
The Host Rules tab allows you to create and modify the host rules for 
access control, as described in the Host Access topic on page 15. You 
can also change the settings for Enable host access checking and 
Default access rule here. 

How to 

Add a Rule 
1. Enter a host name or domain name pattern in the Host name 

field. 
2. Select the access, either Allow or Deny, from the Access 

drop-down list. 
3. Click the Add button. 

Change a Rule 
1. Select a rule in the Host rules list. 
2. Change the value in the Host name field, and/or change the 

selection in the Access drop-down list, as appropriate. 
3. Click the Change button. 

Change Order of the Rules 
1. Select a rule in the Host rules list. 
2. Click the Raise button to have this rule evaluated sooner; click the Lower button to have this rule evaluated 

later. 

Enable host access checking 
Check this box to make RPM check access on each connection attempt.  Uncheck the box to have RPM ignore access 
control. 
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Default access rule 
Use the drop-down list to set the default access to “Allow All” or “Deny All”. The Host Access topic describes how the 
Default access rule is used. 

Host Rules 
The Host Rules list shows the current rules in order, with the first rule at the top. Each rule contains the access control 
(Allow or Deny) and a host name or domain pattern  
 
Select a rule in the Host Rules list. The host name and access appear below the list. You can also use the Raise, Lower, 
or Remove buttons if you have selected a rule. 

Hostname 
The host name for the selected rule appears here. If you are creating or changing a rule, enter the host name here. 
Note that if the Host name field contains an asterisk character (*) that all characters to left of the asterisk will be 
removed when the rule is placed into the Host Rules list. 

Access 
This drop-down list shows you the current access, either Allow or Deny. 

Raise or Lower 
Click the “Raise” button to raise the priority of the selected rule, or cause it to be evaluated sooner. You cannot raise 
the first rule.  Click the “Lower” button to lower the priority of the selected rule, or cause it to be evaluated later. You 
cannot lower the last rule. 

Add/Change/Remove 
Click the “Add” button to add the host name or domain pattern, and selected access, to the list of Host Rules. The new 
rule will appear at the bottom of the list. 
 
Click the “Change” button to change the selected rule. The new rule will use the text in the Host name field, and the 
selected access in the Access drop-down list. 
 
Click the “Remove” button to remove the selected rule. 

IP Rules Tab 
The IP Rules tab allows you to create and modify the IP address rules 
for access control, as described in the Host Access topic on page 15. 
You can also change the settings for Enable host access checking and 
Default access rule here. 

How to 

Add a Rule 
1. Enter an IP address or address pattern in the IP Address 

fields. 
2. Select the access, either Allow or Deny, from the Access 

drop-down list. 
3. Click the Add button. 

Change a Rule 
1. Select a rule in the IP Address rules list. 



RPM version 4.5 
   

Page 45 

2. Change the values in the IP Address fields, and/or change the selection in the Access drop-down list, as 
appropriate. 

3. Click the Change button. 

Change the Order of the Rules 
1. Select a rule in the IP Address rules list. 
2. Click the Raise button to have this rule evaluated sooner; click the Lower button to have this rule evaluated 

later. 

Enable host access checking 
Check this box to make RPM check access on each connection attempt.  Uncheck this box to have RPM ignore access 
control. 

Default access rule 
Use the drop-down list to set the default access to Allow All or Deny All. The Host Access topic describes how the 
Default access rule is used. 

IP address rules 
The IP Address Rules list shows the current rules in order, with the first rule at the top. Each rule contains the access 
control (Allow or Deny) and an IP address or address pattern. 
 
Select a rule in the IP Address Rules list. The IP address and access appear below the list. You can also use the Raise, 
Lower, or Remove buttons if you have selected a rule. 

IP Address 
The IP address for the selected rule appears here. If you are creating or changing a rule, enter the IP address here. 
 
Shortcuts: 

1. Note that the IP address is divided into four fields, much like the address itself. Each field accepts three 
numeric characters, then automatically shifts focus to the next field. The last field shifts focus to the Access 
drop-down list. 

2. When you type an asterisk (*) in any of the fields, the remaining fields (those to the right) are emptied and 
focus shifts to the Access drop-down list. 

  Note: If any part of the IP address contains an asterisk character (*) that all characters to right of the asterisk will 
be removed when the rule is placed into the IP Address Rules list. 

Access 
This drop-down list shows you the current access, either Allow or Deny. 
Raise and Lower 
Click the “Raise” button to raise the priority of the selected rule, or cause it to be evaluated sooner. You cannot raise 
the first rule.  Click the “Lower” button to lower the priority of the selected rule, or cause it to be evaluated later. You 
cannot lower the last rule. 

Add/Change/Remove 
Click the “Add” button to add the host name or domain pattern, and selected access, to the list of Host Rules. The new 
rule will appear at the bottom of the list. 
 
Click the “Change” button to change the selected rule. The new rule will use the text in the Host name field, and the 
selected access in the Access drop-down list. 
 
Click the “Remove” button to remove the selected rule. 
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Hostnames Tab 
The Host Names dialog allows you to build a local host table for 
reverse name lookups; RPM looks for an IP address and wants to find 
a corresponding host name. 

  Note: Do not use domain or IP address patterns in this dialog. 

How to 

Add an IP Address and Hostname 
1. Enter an IP address in the IP address field. These fields 

accept leading zeros and automatically move to the next field 
when you have entered three characters. 

2. Enter a host name in the Host name field. 
3. Click the OK button. 

Change the Hostname for an IP Address 
1. Select the IP address in the Hostnames list. 
2. Change the host name in the Host name field at the bottom of 

the dialog. 
3. Click the Change button. 

Hostnames 
The Hostnames list shows the current collection of IP addresses with corresponding host names.  Select an item in this 
list to change or remove it. 

IP Address 
The IP address for the selected rule appears here. If you are creating or changing a rule, enter the IP address here. 

  Note: The IP address is divided into four fields, much like the address itself. Each field accepts three numeric 
characters, then automatically shifts focus to the next field. The last field shifts focus to the Access drop-down list. 
Unlike the IP Rules dialog, this dialog interprets each part of the IP address as a decimal number. The asterisk wildcard 
is not supported. 

Hostname 
The host name corresponding to the IP address entered above, goes in this field. Use a fully qualified domain name if 
possible. 

Add/Change/Remove 
Click the “Add” button to add the current IP address and host name to the Hostnames list. 
 
Click the “Change” button to remove the currently selected IP address and host name, and replace them with the fields 
entered above. 
 
Click the “Remove” button to remove the currently selected IP address and host name pair. 

Log Options dialog 
Use the Log Options dialog to set RPM logging options.  You can find a description of the RPM logging facility 
including an explanation of the following terms in the topic How to Use Logging Options on page 21. 
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Enable network logging 
If this setting is on, RPM will log network events. 

High detail (Network Logging) 
If this setting and Enable network logging are both on, RPM will log network 
events in significant detail. 

Enable queue logging 
If this setting is on, RPM will log events for RPM queues. 

High detail (Queue Logging) 
If this setting and Enable queue logging are both on, RPM will log queue events in significant detail. 

Enable print logging 
If this setting is on, RPM will log printing events. 

High detail (Print Logging) 
If this setting and Enable print logging are both on, RPM will log print events in significant detail. 

Save control file from host 
If this box is selected, RPM will save the control file to the disk along with the data file.  By default, the control file is 
saved to the RPM Spool folder; this location can be modified in the Print Data Options dialog, discussed on page 52. 

LPD Options dialog 
The LPD Options menu item invokes the LPD Options dialog. These options 
involve the LPD protocol, a fairly esoteric topic. RPM can also allow and deny 
access based on the host name or IP address of the remote computer. See the 
Host Access topic on page 15 for more information. 
 
In previous RPM versions, these options were all disabled.  Now, all LPD 
Options are enabled which allows non-standard client to easily send data to 
RPM.  If you upgraded RPM from a previous version, these options should be 
manually enabled as the upgrade keeps current configuration intact. 

Relax the AF_INET requirement 
This relaxes the requirement that the print client use a certain (typical) option in they way they connect to RPM. 
You will know if you need to set this option on if you see the following message in the Log window: 

Client protocol: AF_INET is expected 

Relax the 'port in range' requirement 
This relaxes the requirement that the client use a port in the reserved range, from zero to 1023. 
You will know if you need to set this option on if you see the following message in the Log window: 

Client port n is out of range 
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Enable zero length file transfers 
This option, when enabled, forces RPM to close the connection of a zero length file transfer after the number of 
seconds specified in the “Zero length timeout” field.  A zero length file transfer is defined as “all data received until the 
connection is closed”. 

Operator Job Control dialog 
The Operator Job Control dialog allows you to remove a job without printing or processing it; you can also hold it for 
printing later, change the starting page, and move jobs between queues.  RPM currently does not allow you to delete a 
job while it is being transferred to your PC, or while it is printing. 

How to 

Remove a Job 
You can only remove jobs when the Queue Status window (see page 14) is 
open. Use the Window menu (see page 29) if you are not sure the Queue 
Status window is open. You can also use the View menu (page 28) to open 
the Queue Status window. 

1. In the Queue Status window, select the job you wish to remove.  
Hint: The easiest way to do this is to first suspend the queue (see 
page 14) or make sure the job is held. 

2. Double click the job, or highlight the job in the Queue status 

window and click the Operator button  on the toolbar, or select 
Operator from the Queues menu (page 27) 

3. If the job is not in transit, or is being printed, click Delete Job to remove the job.  RPM will remove the control 
file for this job, and all associated data files. 

Manually Release a Held Job 
1. Select the job as shown above. The Operator Job Control dialog shows the job sequence number and other 

identifying information. 
2. If the job is held, then the Hold (set ON to print job later) checkbox is marked ON. Click the checkbox; the job 

will immediately be submitted for printing, and the job information will be removed from the Operator 
display. 

Move a Job from One Queue to Another 
1. Select the job as shown above. 
2. Next to the Move Job button is a drop-down list containing names of queues other than the current queue. 

Select a queue, then click Move Jobs 

Queue 
The Queue drop-down list contains the names of the currently defined queues. When you select a queue, RPM puts the 
unique sequence number for all jobs in that queue in the Jobs list. 

Jobs 
The Jobs list contains the unique sequence number for all jobs in the queue selected in the Queues list. When you select 
a job, RPM displays identifying information for that job. 
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Item/User/Host/Title/Status 
These fields contain information describing the selected job. 

Starting/Ending page 
RPM is able to start printing on a page other than the first and finish printing before the last page. Enter a numeric 
value greater than 1 for the starting page if you want to skip pages.  If  “Ending page” is set to 0, then RPM will not 
finish until the job is completely printed. 

  Notes: For Text printing, RPM uses the values you enter in the Text Setup dialog (page 58) to count pages. 
However, for pass-through printing, RPM relies on page separators and your results may not be what you expect. 
 
If you choose a starting page greater than the last page RPM encounters when printing, it holds the job and alerts you 
with a dialog box. 

Hold (set ON to print job later) 
This checkbox is marked ON if the job is held. In this case, click the checkbox to immediately release the job for 
printing.  

Move Job 
Click this button to move the current job to the queue you have selected in the to queue drop-down list. 

Delete Job 
Click this button to remove the current job.  

Pass-through Setup dialog 
Sometimes when you send data directly to the printer, you may want RPM to make slight alternations first. You should 
do this only with plain text or text with escape sequences. We do not recommend using these options with binary files 
such as PCL or HPGL (the languages of Hewlett Packard printers and plotters, respectively), nor should they be needed 
with PostScript. However, you should experiment to see what works best in your situation. 

Translate LF to CR/LF 
When printing from a Unix system, or another computer that uses a single line 
feed to end a line, DOS printers may not print properly.  If you see a single line 
at the top of the page or a “stair-step” effect, this setting should be enabled. 

Add page separator 
In some situations, the printer must be configured to eject the page when it finishes a print job.  If print jobs start where 
the previous ones end, enable this option. 

Page Separator 
By default, RPM uses the form feed character (hex 0C) as a page separator. Click this button to define your own page 
separator string, using the Edit Bytes dialog (see page 37). 

Print Data Options dialog 
The Print Data Options dialog allows you to make changes to your print job before printing. These options are in effect 
no matter what the queue type is. 
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Transform tab 

Remove PCL codes 
RPM can remove PCL and PJL codes from a data stream, leaving plain 
text.  Hewlett Packard printers use these codes.  Note that RPM does 
this automatically for text queues. 

ASA carriage control / Fortran 
When this feature is enabled, RPM will translate data that is formatted 
with FORTRAN or ASA carriage control codes.  RPM will translate 
automatically when this box is unchecked if the LPR request using the ‘-
r’ option. 

Convert SCS to ASCII 
SCS is an EBCDIC based markup language found on IBM mainframes and AS/400 midrange systems. 
 
Select this setting to translate SCS markup commands.  If you are using a text queue then RPM reproduces the original 
formatting for many SCS commands.  Otherwise, RPM performs a simpler translation.  If you select this function, 
RPM assumes that it will also be doing EBCDIC translation and will use the selected language setting as described 
below. 

EBCDIC 
Select this setting to translate EBCDIC into ASCII, using the selected language setting as described below. 

Use (language) 
IBM has defined extensions to EBCDIC for many locales.  RPM currently supports these extensions for a variety of 
European languages.  Examples of extensions include but are not limited to accented characters and diacritics.  While 
RPM directly supports only characters found in ISO 8859-1, planned enhancements will provide support for a much 
broader range. 
 
RPM attempts to match the EBCDIC language extension to your computer's locale.  However, you can select any 
language setting. 

Translate tab 
RPM can perform character-by-character translations; see the Translations topic for more information. 

Use translation 
Put a check in this box if you want RPM to perform translations. The 
translation table must also be selected for this to be in effect. 

Translation table 
The Translation Table drop-down list contains the names of the 
currently defined translation tables. The selected table will be used for 
this queue. 

Edit Translation 
Click this button to bring up the “Edit Translations” dialog.  
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Translation Tables 
Click this button for a shortcut to the Translation Tables dialog.  This way you can edit the contents of the translation 
table that RPM will use for this queue. 
 

  Note:  If you do not have a table selected in the “Translation Table” drop-down list, this button brings up the 
Edit Translations dialog so you can choose which table you wish to edit. 

Insert tab 
RPM can insert either a set of bytes or a file at the beginning of a print 
job. 

Insert function 
From this drop-down list, select the insert function you wish for RPM to 
perform. Values are: 
<none> RPM will not insert 
Insert bytes RPM will insert a byte sequence that you create 
Insert file RPM will insert the contents of a file 
 
The default function is "<none>". 

Edit Bytes 
Click this button to create or review the bytes that RPM will insert before a print job. RPM uses the Edit Bytes dialog 
(see page 37). 

Browse 
Click this button to select a file for RPM to insert. 

File / Bytes 
A static control is also provided that displays the path for the file RPM will insert, if you have selected the "insert file" 
function or the bytes to be inserted if you have selected the “insert bytes” function. 

Print Banner 
This option provides the ability to configure the banner page option.  You can configure RPM to never print a banner 
page (suppress banner), to print when requested by the sending side (when requested), and to always print, regardless 
of whether the client requests it (always print). 

Insert 
This option allows you to insert data either before or after the banner page.  This option is disabled unless both insert 
function and print banner are turned on. 
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Append tab 
RPM can append either a set of bytes or a file at the end of a print job. 

Append function 
From this drop-down list, select the append function you wish for RPM 
to perform. Values are: 
<none> RPM will not append 
Insert bytes RPM will append a byte sequence that you create
Insert file RPM will append the contents of a file 
 
The default function is "<none>". 

Edit Bytes 
Click this button to create or review the bytes that RPM will append to a print job. RPM uses the Edit Bytes dialog. 

Browse 
Click this button to select a file for RPM to append 

File / Bytes 
A static control is also provided that displays the path for the file RPM will append, if you have selected the "append 
file" function or the bytes to be appended if you have selected the “append bytes” function. 

Other tab 

Remove bytes at the start of the data 
If this box is checked, RPM will remove the specified number of bytes 
from the beginning of a print job.  Do this if your remote host is sending 
text data that starts with some number of non-text characters. 

Number of bytes to remove 
Enter the number of bytes for RPM to remove.  This will only take 
effect if you have checked “Remove bytes at the start of the data”. 

Manage print job properties 
Check this box if you wish the Windows spooler to show the originating user and title of the job.  It is checked by 
default during installation.  If this feature is enabled, the RPM service account must have full access to the destination.  
If it does not, RPM will then turn this feature off and try again. 

Suspend queue on printer error 
This box is checked by default.  By default, RPM will “Suspend” the queue if there is a problem with the destination 
printer or folder.  If this box is unchecked, RPM will “Hold” each job rather than suspending the queue.  For more 
information on the queue states, see page 14. 

Place control files in this directory 
Control files are saved based on the setting in the Log Options dialog.  You can specify a folder to save files to other 
than the default, which is the RPM Spool folder. 
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Print Setup dialog 
The following options allow you to select the destination printer and its connection. 

Printer 
Select the printer you want to use. Choose the Default 
Printer; or choose the specific printer you wish this queue to 
print to using the Name drop-down list.   

  Note: You install printers and configure ports using 
the Windows Control Panel.  

Orientation 
Choose Portrait or Landscape. 

Paper Size 
Select the size of paper that the document is to be printed 
on. 

Paper Source 
Some printers offer multiple trays for different paper sources. Specify the tray here. 

Properties 
Displays a dialog box where you can make additional choices about printing, specific to the type of printer you have 
selected. 
 

  Note: Options such as orientation, paper size, orientation and other option in the printer properties are support 
with text type queues only.  To see a description of queue types, see page 13. 

Rename Queue dialog 
The Rename Queue dialog changes the name of a queue in RPM. The topic 
"Rename an existing queue" on page 20 discusses this further. This topic gives 
detail on using the actual dialog. 

Existing queue name 
This field shows the current name of the queue you are assigning a new name 
to. It is blank unless you selected a queue in the Queue Status window prior to 
opening the Rename Queue dialog, or until you select a queue in the Existing 
queue names list. 

New name for queue 
Fill in the new name you wish to use for the selected queue. 
Note that RPM treats upper and lower case the same for queue name comparisons, so you do not need to rename a 
queue from "lp" to "LP", for example. 



RPM version 4.5 
   

Page 54 

Existing queue names 
This list provides the names of the currently defined queues. As you type the queue name, RPM attempts to verify that 
the name is not already in use. RPM may highlight a name in this list if it matches what you have typed. This is only 
meant to inform the user of possible name conflicts. 

OK 
The Rename Queue dialog will attempt to rename the queue from the existing name to the new name, after filtering out 
invalid characters (such as space) and verifying that the new name is not already used for a queue. 
 

  Note: The OK button requires you to enter a new name, and select an existing queue name. 

RPM Settings dialog 
The settings menu option invokes the Settings dialog. The meaning of these 
items is explained in "Configuring RPM" on page 11. Below we offer 
guidelines for using this dialog. 

Log file expiration 
RPM keeps a log file for each day RPM is run.  The default number of days 
that RPM keeps each log file is seven.  After that, RPM will automatically 
delete them.  You can change RPM to keep the log files between 1 and 366 
days, or up to 1 year and a day. 
 
You must exercise caution to make sure your disk does not fill up. 

Automatically create queues on request 
When this box is checked, RPM will automatically create a queue if it gets request for one that does not already exist.  
The queue is then suspended.  At this point, you will need to change the options and printer selection for the queue 
before printing will resume.  This feature is on by default. 

Select Queue dialog 
This dialog automatically comes up if you try to change a queue state from the “Queues” menu without having a 
particular queue selected in the “Queue Status” window.   

Select a Queue 
This is a listing of the currently defined queues in RPM. 
 
Highlight the queue you wish to select and press the OK button. 
 
Shortcut: 
Simply double clicking on a queue is the same as highlighting a queue, and 
clicking the OK button. 
 

  Note: Click the Cancel button to close the dialog without selecting a queue and changing the state. 
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Server Protocols dialog 
RPM allows you to use TCP/IP printing protocols other than LPD. Currently, 
RPM supports the telnet (reverse telnet or streams) protocol. This protocol 
requires you to set a TCP/IP port. RPM also requires that you pick a RPM 
queue to send print requests to. 
 

  Note: Specialized applications use the streams protocol. If you are having 
problems printing in RPM, consult the "Common Printing Problems" topic on 
page 10 before you change any of the settings in this dialog. 
 
RPM allows you to define as many protocols as you like, and it will attempt to 
monitor all of them. 

How to Create a Telnet Port 
1. Select a protocol from the Protocol type list. This will almost always be telnet. 
2. Enter a port in the TCP/IP port field. For example, a typical port might be 100. Do not enter a port that is 

already in use. 
3. Click the Setup button for more required configuration. 

Current protocols 
This list contains the currently defined protocols. Each protocol consists of a name and a port number. Names are either 
"lpd" or "telnet"; other names will be added if RPM supports additional protocols. The port number describes how 
TCP/IP finds a server, along with the IP address and other protocol information. 
The default port number for the LPD protocol is 515. Do not change this value unless you have a very good reason to 
do so; experimenting with it will most likely make RPM not work. Print clients expect to contact the print server (e.g., 
RPM) at port 515. 

Protocol type 
When you define a new protocol, select the protocol type from this list. Chances are that most or all of your new 
protocols will be "telnet" and not "lpd". 

TCP/IP port 
Enter a port number greater than zero (0) and less than 65,536. For telnet protocols, consult your network administrator 
or the person responsible for the streams printing clients. 

Setup 
Click this button to get the Telnet Setup dialog (see page 56) for the selected protocol. RPM requires certain setup 
information for telnet protocols before it can accept input on those protocols. 

Add 
Click the Add button to add a protocol definition to the Current Protocols list. 

Change 
Click this button to change the selected protocol to use the Protocol type and TCP/IP port values. 

Delete 
Click this button to remove the definition for the selected protocol. 
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Styles dialog 
The Styles dialog allows you to copy settings from any RPM queue and store 
them in a named style. You can create, rename, and delete styles using this 
dialog. 

How to 

Create a Style 
1. Enter a name in the Style Name field. 
2. Click the Add button. 

Copy Settings from a Queue 
1. Select a style in the Styles list. 
2. Select a queue in the drop-down list labeled Copy attributes of queue to selected style: 
3. Click the Copy button. 

Rename a Style 
1. Select a style in the Styles list. 
2. Enter a new name in the Style name field. 
3. Click the Rename button. 

Styles 
The Styles list contains the names of the currently defined styles. Note that style names can contain spaces and other 
non-filename characters. 

Style name 
The Style name field allows you to enter a style name. 
Add Rename or Remove 
Click the “Add” button to add the name in the Style name field to the defined styles in the Styles list.  Click the 
“Rename” button to rename the selected style to the name entered in the Style name field.  Finally, click the “Remove” 
button to remove the selected style. 

Copy 
This button copies attributes of queue to selected style.  Select a queue from 
this drop-down list; when you click the Copy button, this queue will be the one 
whose attributes are copied.  Be sure you have a “Style” selected. 

Telnet Setup dialog 
The “Telnet Setup” dialog determines how RPM will print data it receives from 
a Telnet client. 

How to 

Configure a telnet port 
1. A queue must be selected from the “Submit jobs to queue” list.  This 

is required information and there is no default. 
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2. When printing text through RPM, we recommend that the user name and title fields be supplied.  This 
information is used for the Windows Print Manager. 

3. The “Queue pages before printing” field determines whether RPM will print while connected, or wait until the 
connection is closed. 

Setup for protocol 
This field contains the name of the protocol, Telnet, and the TCP/IP port number that RPM will monitor for incoming 
data. 

Submit jobs to queue 
This drop-down list contains all queues currently configured in RPM.  Select a queue from this list that RPM will 
submit jobs to when data is received on this Telnet port. RPM will not accept data sent to this protocol without a queue 
selected here.  There is no default. 

Print banner page 
When checked, RPM will format and print a banner page containing the username, client host name, banner class, and 
job name.  When this setting is not checked, RPM will not print a banner page.  The banner page applies to both “Text” 
and “Raw” printing. 

Job name/User ID/Title 
These fields specify values typically sent by an LPR print client.  When “Print banner page” is checked, this 
information is used on the banner page. 

Copies 
An LPR print client may specify that RPM should print more than one copy of a print job. The Copies field has the 
same effect. 

Use width 
LPR print clients can specify the width when printing.  Since Telnet printing does not have this ability, RPM can be 
used to specify number of “columns-per-line”.  If checked, and a number of character is specified, RPM will use this 
field to determine the font size needed to match the criteria.  

Print type 
An LPR print client typically specifies a print type. Choose a print type from the Print type drop-down list.  The 
choices here indicate the print types that RPM currently handles. 

Queue pages before printing 
If the setting in Queue pages is zero, RPM will wait until all data is received and the connection has been closed before 
submitting data to the printer. 
 
If the setting in Queue pages is greater than zero, RPM will submit data to be printed when the number of pages it has 
received reaches or exceeds the setting, without waiting for the telnet connection to close. 

Print pages when quiet 
When checked, RPM will print data it has received if the connection is still open, but data has not been received for ten 
seconds or more.  Otherwise, RPM prints data only after the connection has been closed.  RPM waits indefinitely until 
the client closes the connection. 
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When to use this setting: This selection should be ON if your connection remains open for a long period of time, and 
you wish to print when the network activity stops temporarily. 
 

  Note: See the “Server Protocols” dialog on page 55 for more information on Telnet ports. 

Text Setup dialog 
Use this dialog to edit settings used by Text queues (see page 13). Please note that there are many options, and that 
some options work differently depending on other values. Also, note that the Font dialog saves its changes when you 
close it, not when you close the Text Setup dialog. 
 
Use this dialog to edit settings used by Text queues. Please note that there are 
many options, and that some options work differently depending on other values. 

How to 

Make Long Lines Shrink to Fit 
1. Select a font if you have not already selected one. We recommend that 

you choose the face name you prefer and use the default point size, or 
select 12 for the point size. 

2. Select the setting Fit columns per line if it is not already ON. Enter the 
anticipated line length value in the "columns" field. 

Using these settings, when RPM prints it will calculate characters-per-inch using 
your line length and the horizontal distance between the left and right margins. 

Stop Control Characters from Printing 
This may be a little harder than it seems. If you use the setting Remove control 
characters before printing, RPM will remove non-printable characters whose 
value is less than the space character (hex 20). This works for some situations. 
But, you may still see "garbage" characters including boxes. The reason for this is that the remote print client is sending 
bytes to control the printer, which usually include the Escape character and several printable and non-printable 
characters. 
 
If these bytes are all at the beginning of the print job, you can use the Print Data Options dialog to remove these 
characters. Otherwise you may have best results by changing the queue type from Text to Pass-through. 

Stop Printing the Banner Page 
You can stop RPM from generating a banner page by selecting "Never print the banner page."  If your remote host is 
generating a banner page, then we recommend that you hold the queue, and use the Operator Job Control dialog to 
begin printing on page 2. 

Make 60 Lines Fit on a Page 
Select the setting “Fit lines per page”.  Enter 60 in the lines/page field. 

See What Physical Margins My Printer is Using? 
Go to Options/Log and select "Enable print logging" and "high detail". The RPM log window will show the physical 
printer margins when you send a job to that printer. 
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Code Page List 
RPM queries Windows for the code pages installed on your system. For instance, if your computer has Japanese 
language support installed, then you should see "Japanese" included in this list. 
 
When you select a code page, RPM displays the Font dialog and instructs it to find fonts that support this language. 
 

  Note: If you select a wide character set such as Japanese, RPM has the following restrictions: 
1. It will not attempt to wrap lines. 
2. It will not attempt to print line segments ("Use CR to overwrite lines"). 
3. It will not remove control characters. 
4. It will not translate EBCDIC to ASCII, do SCS conversion, remove PCL codes, or use custom translation 

tables. 

Font button 
The text on the button face shows the name and size of the font selected for this queue.  If the user does not select a 
font, RPM uses the default "Courier New 12". 
 
Press this button to change the font face and/or size.  

Page margins 
RPM offers the user the option to set margins for the printed page. RPM supports a number of widely used units for 
setting fonts, including Inches, Millimeters, Points, and Picas. If your industry uses a unit other than these, please send 
email to support@brooksnet.com describing your needs. When you change the unit of measure for the margins, RPM 
automatically converts the margin settings. 
 
Select margin units from the Margin Units drop-down list. Set your top, left, bottom, and right margins in the fields 
provided. 
 
RPM attempts to use true margins, taking into account the physical page size and non-printing area at the top and left of 
the page, according to Windows. RPM supplies 1/2 inch as a default margin for the Top, Bottom, Left, and Right edges 
of the page, but you should change these settings to suit your needs. 
 

  Note: The smallest margin your printer supports may be larger than the setting in RPM. 

Horizontal and Vertical Specifications 
RPM supports two ways each to specify horizontal and vertical sizes. You can use lines-per-inch or lines-per-page, not 
both.  Similarly, you can use characters-per-inch or columns-per-line, but not both. 
 

  Note: The font height and width are independent: If you specify both the width and height, RPM will stretch 
or compress the font. If you specify only the width or height, RPM preserves the normal shape of the font. 

  Note: RPM will use your selected font size only if the height is smaller than the font scaled height. For 
example, if you select an 8-point font and 6 lines per inch, RPM will use the smaller 8-point size and place the 
lines as you specify. 

Use lines per inch 
To use this setting, you must check “Use lines per inch” and type a value in lines/inch box to cause RPM to print a 
specific number of lines-per-inch.  RPM will reduce the font size automatically if necessary. If you select both "lines-
per-inch" and "characters-per-inch", lines-per-inch is reinforced by RPM and characters-per-inch may be reduced to 
accommodate your lines-per-inch settings. 
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How to calculate lines per inch: Each page I want to print contains 66 lines per page.  The paper setting is portrait and 
the length of the page is 11 inches.  The margins are set to 0.5 inches Top and Bottom. 
LPI = 66 / (11 - (0.5 + 0.5)) = 6.6 

Fit lines per page 
When you select Fit lines per page and use a value in lines/page, RPM determines the vertical distance between the top 
and bottom margins, and calculates the lines-per-inch. This is a good way to achieve goal oriented printing, where you 
state what you want and allow RPM to generate the right results. 

Use characters per inch 
To use this setting, check the “Use characters per inch” box and specify a value in chars/inch field.  RPM will now 
generate a font of the appropriate width.  If you select both "lines per inch" and "characters per inch", lines-per-inch is 
reinforced by RPM and characters per inch may be reduced to accommodate your lines-per-inch settings. 
 
How to calculate characters per inch: The lines to be printed contain up to 80 characters.  The paper setting is portrait 
and the page width is 8.5 inches.  The margins are 0.5 inches Left and Right 
CPI = 80 / (8.5 - (0.5 + 0.5)) = 10.66 

Fit columns per line 
RPM allows you to set a maximum line length, and specify whether or not it will be used. RPM considers tabs when 
calculating line length. When you select this setting and specify a value in the Columns field, RPM calculates the 
correct characters per inch using the horizontal distance between the left and right margins. 
 
This setting also works with the Wrap lines setting. 
 
When you check this box, RPM turns on Wrap lines. With Wrap Lines on, and Maximum line length on, RPM will 
wrap lines using the length specified. 
 
If this setting is on but Wrap-Lines is off, RPM will truncate lines using the length specified. 

Use CR to overwrite line 
Some hosts use the line feed character to mark the end of a printed line, and the carriage return character to denote a 
line that is to be overprinted, or printed on top the current line. Select Use CR to overwrite line to cause RPM to 
recognize this convention. Normally, RPM treats line feed, carriage return, and carriage return/line feed as line 
terminators. 

Wrap lines 
RPM has the ability to wrap lines. The way RPM does this depends on whether the Maximum line length is set or not. 
If “Fit columns per line” is checked, RPM uses the character count to determine if a line is too long, taking tabs into 
account. 
 
If “Fit columns per line” is unchecked, then Windows calculates the length of the line using the current font, and 
determines if the line will fit between the current left and right margins. 
 
If needed, RPM can use both white space (space and tab) and non-word characters to find a place to break a line. Word 
characters are A to Z (upper and lower case), digits, and some punctuation characters. Dashes and hyphens are not 
included, so these can break a word. 
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Remove control characters 
Our tests have shown that some systems insert NULL characters (that is, a character with the ASCII value zero) into a 
print job before sending it to RPM. Apparently some printers ignore these characters, but Windows will not. 
RPM gives you the ability to strip control characters from the file before printing. In this context, control characters are 
defined as characters with ASCII value less than the space character, excluding carriage return, line feed, and form 
feed. 

Use maximum lines per page 
RPM allows you to set the maximum number of lines to print on a page. RPM will pick the lesser of this value, if you 
specify it, and the value determined by the font, page size, and top and bottom margins. RPM uses the lines/page value 
from "Fit lines per page". 
 

  Note: For most users "Fit lines per page" supercedes this function. 

Never print banner page 
The LPD protocol specification says that the banner is printed by default, and the print client must suppress the banner 
for each job. However, RPM allows you to suppress the banner for a queue, whether the print client does or not. 

Suppress blank pages 
If this setting is on, then RPM will not print a new page following a form feed or blank lines exceeding the page height, 
until it sees data on the new page. Note that this setting is on by default. This should help RPM accommodate many 
mainframe based systems, for example. 

OK/Cancel 
The OK button closes the Text Setup dialog and saves changes.  The Cancel button closes the Text Setup dialog 
without saving the changes except if you have changed the font, in which case, that change has already been saved.  
Note that the font dialog saves its own changes independent of the Text Setup dialog. 

Translation Tables dialog 
The Translation Tables dialog allows you to create and manage named translation tables. See the Translations topic on 
page 17 for more information on RPM translations. 

How to 

Add a Table 
1. Enter a table name in the Table name field. Use a name that does not 

already exist. 
2. Click the Add button. 
3. Click the Contents button to define a set of translations. See the Character Translations topic on page 34 for 

more information. 

Rename a Table 
1. Enter a new name in the Table name field. 
2. Select a table name in the Existing tables drop-down list. 
3. Click the Rename button. 
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Edit the Contents of a Table 
1. Select a table name in the Existing tables drop-down list. 
2. Click the Contents button. The Character Translations dialog appears, with your table selected. 
  Note: If you do not define any contents for a table, RPM will not create it. 

Existing tables 
The “Existing tables” drop-down list contains the names of translation tables already defined in RPM. This list is empty 
if none are defined. 

Table name 
The “Table name” field allows you to enter new and changed table names. As you type a name into this field, RPM 
searches the list of existing names and highlights a match, if found. 

Add/Rename/Delete 
Click the Add button to create a table; the contents of the Table name field are used for the new name.  Click the 
Rename button to change the selected table to the name in the Table name field.  Click the Delete button to remove the 
currently selected table, and the definitions in it. 

Contents 
Click the Contents button to edit the contents of the currently selected table, using the Character Translations dialog. 

Use Job Data dialog 
The Use Job Data dialog is used for saving your filename under different names than normal.  There are now many 
ways to save the file for ease of recognizing where, when, or who actually sent the file to RPM.  This will allow for 
better tracking in your organization.  

Available 
These are the options available for use in your filename that you 
have not already used.  There are a variety of things to choose.  
For instance, if you want to save your file based on who sent it 
and when they sent the file, you would choose "User" and 
"Date/time 

Used 
This is the box showing which options you have chosen to use 
for your filename. 

Add/Remove  
These buttons allow you to add available job data or remove 
used job data. 

Separator 
This is the character you want separating your data in the filename.  For instance you can make your filename 
'dave_www.brooksnet.com.txt' or 'dave-www.brooksnet.com.txt".  It just depends on what you want separating the 
data. 
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Date/time 
This is where you would choose the format for the date.  You can choose a 2-digit or 4-digit year, whether you want the 
year coming first or last, etc. 

Use Style dialog 
The Use Styles dialog allows you to copy the queue settings saved in a style, 
back to a queue. This way you can easily change the behavior of a RPM queue. 

Use Style 
Click the Use Style drop-down list to select which style you want your queue to use. 

In Queue 
Click the “In Queue” drop-down list to select which queue to copy the style contents to. 

Report2Web 
There is one style built-in to the RPM software.  It is called “Report2Web” and is used for integration with the 
Report2Web software.  Report2Web is a separately purchased and installed system, and is available from Report2Web 
at http://www.report2web.com. 
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Errors and Warnings Generated by RPM 
Errors Indications or Fixes 
108 Couldn't create a SCM dispatch thread This would indicate low resources. 

110 Register service control handler failed RpmSrvc.exe should only be launched through the 
Service Control Manager. 

111 Service control dispatcher error <id> : <text> RpmSrvc.exe should only be launched through the 
Service Control Manager. 

121 The license has expired RPM’s trial license has expired.  License RPM to restore 
service. 

123 Windows sockets initialization failed May indicate a resource shortage or incorrect network 
software installation. 

124 MFC resource initialization failed with error <id> : 
<text> 

Indicates an incomplete or corrupted install. 

125 CBisiLock::GetLicenseData() produced: <text> Indicates an incomplete install, registry protection 
problem, or corrupted license. 

126 Couldn't initialize license Indicates an incomplete install, registry protection 
problem, or corrupted license. 

128 Unable to create dispatch window Indicates a severe resource shortage. 

240 Queue cleanup failed This is most likely due to a registry key protection 
problem. 

383 Couldn't determine RPM spool directory RPM was not able to determine the spool directory 
location.  See above… 

384 Error making spool directory <path> 0x<id> : 
<text> 

The service needs "create" permissions on the RPM 
directory. 

399 BisiLock not created Indicates an incomplete install, registry protection 
problem, or corrupted license. 

400 BisiLock not created Indicates an incomplete install, registry protection 
problem, or corrupted license. 

423 BisiLock not created Indicates an incomplete install, registry protection 
problem, or corrupted license. 

430 The license is not valid for this product RPM was attempting to load a license for a different 
product. 

Warnings Indications and fixes 

109 Unknown service control opcode 0x<id> The service registration is corrupted. 

144 Port <x> socket returned Create() error 0x<id> : 
<text> 

This is not currently used. 

145 Port <x> socket returned Listen() error 0x<id> : 
<text> 

Another RPM protocol or network server application may 
be using that port. 

146 Port <x> socket returned Accept() error 0x<id> : 
<text> 

The client may have terminated the connection. 

147 Port <x> couldn't create connection This would indicate severely low resources. 

151 Socket <x> error [0x<id>] : <text> Windows returned an unexpected socket error. 

160 Socket <x> received unknown command 0x<id> 
with arguments <text> 

The command is probably an extension from the RFC 
unknown to RPM. 

181 Error writing data to port <x> [0x<id>] : <text> Windows returned an error when RPM attempted to write 
data to a client. 

183 Error reading data from port <x> [0x<id>] : <text> Windows returned an error when RPM attempted to read 
data from a client. 

186 Socket <x> unrecognized LPD command <text> The LPR sent a command not recognized by RPM. 

187 Open RPM message definition file RpmMsg.dll 
returned 0x<id> : <text> 

Windows returned an error when RPM tried opening the 
message resources. 

188 Port <x> socket returned SetSockOpt() error 
0x<id> : <text> 

Error when RPM was setting socket options to reuse the 
protocol’s port address. 

190 Socket <x> rejecting job on queue <name> no such A client specified a non-existent queue and automatic 
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queue queue creation is disabled. 

191 Socket <x> rejecting job on queue <name> queue 
not enabled 

The specified queue is disabled (not accepting transfers). 

195 Problem resolving IP address <ip> 0x<id> : <text> Error while RPM was attempting to resolve an IP address 
to a host name. 

197 Socket <x> rejecting job on queue <name> couldn't 
determine originating address 0x<id> : <text> 

Client IP address could not be converted to a host name 
when access checking on. 

200 System error for Key <path> 0x<id> : <text> Windows returned an error while RPM was accessing a 
registry key. 

201 System error for Key <path> value <name> 0x<id> 
: <text> 

Windows returned an error while RPM was accessing a 
registry value. 

202 Couldn't check client address <ip> Registry access failed: RPM attempted to check the 
client’s IP access. 

203 Couldn't check host address <name> Registry access failed: RPM attempted to check the 
client’s host name access. 

204 Couldn't check IP rule <x> Registry access failed: RPM attempted to check an IP 
rule. 

205 Couldn't check host rule <x> Registry access failed: RPM attempted to check host 
name rule. 

206 Couldn't set IP rule <x> to <ip>, <access> Registry access failed: RPM attempted to set an IP rule. 

207 Couldn't set host rule <x> to <name>, <access> Registry access failed: RPM attempted to set host name 
rule. 

208 Couldn't check access enabled Registry access failed: RPM attempted to determine if 
access checking is enabled. 

209 Couldn't check default access Registry access failed: RPM attempted to check the 
default access rule. 

210 Couldn't reset IP rules Registry access failed: RPM attempted to remove all IP 
rules. 

211 Couldn't reset host rules Registry access failed: RPM attempted to remove all host 
name rules. 

214 Printer '<name>' is not defined by Windows RPM 
has suspended queue <queue> and will hold further 
print jobs until the problem is resolved 

The printer has disappeared from the system.  Reselect 
printer in “Printer Setup”. 

215 Port <x> is not defined by Windows RPM has 
suspended queue <queue> and will hold further print 
jobs until the problem is resolved 

The printer port is gone from the system.  Reselect 
printer in “Printer Setup”. 

216 Unable to open file '<path>' <id> : <text> Error when RPM attempted to open the file for printing. 

218 Opening insert file <path> 0x<id> : <text> Error when RPM attempted to open the insert file for 
printing. 

220 Opening append file <path> 0x<id> : <text> Error when RPM attempted to open the append file for 
printing. 

221 Unable to open file: <path> RPM was unable to open the file for printing.  This is a 
high level message. 

225 Windows has no default printer No printer was selected for the queue.  Select a printer 
using “Printer Setup”. 

226 Unable to print to <printer>. Windows was unable to 
open a print device context to device <printer> port 
<port> using driver <driver>. 

Windows could not create a device context for the print 
job. 

232 Error opening file <path> for copy 0x<id> : <text> Windows returned an error when RPM attempted to open 
the append file for copy. 

234 Cannot run filter '<path>' 0x<id> : <text> Windows returned an error when RPM attempted to 
execute the filter program. 

235 Couldn't initialize queue manager Registry access failed: RPM attempted to initialize the 
queue manager. 

236 Couldn't get number of sub-keys Registry access failed: RPM attempted to determine how 
many queues are defined. 

241 CQMgr::JobFileName() failed Registry access failed: RPM attempted to initialize the 
queue manager. 

243 CQMgr::VerifyQueue() failed Registry access failed: RPM attempted to verify a queue. 

245 CQMgr::StartPrint() failed Registry access failed: RPM attempted to schedule a 
transferred job for printing. 

246 CQMgr::IsEnabled() failed Registry access failed: RPM attempted to check whether 
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a queue was enabled. 

247 CQMgr::SetEnabled() failed Registry access failed: RPM attempted to modify whether 
a queue was enabled. 

248 CQMgr::IsRunning() failed Registry access failed: RPM attempted to check queue 
state. 

249 CQMgr::SetRunning() failed Registry access failed: RPM attempted to check queue 
state. 

250 CQMgr::IsHolding() failed Registry access failed: RPM attempted to check queue 
state. 

251 CQMgr::SetHolding() failed Registry access failed: RPM attempted to check queue 
state. 

252 CQMgr::IsPrinting() failed Registry access failed: RPM tried to decide whether a 
queue was printing a job. 

253 CQMgr::SetPrinting() failed RPM attempted to change whether a queue was printing 
a job. 

255 CQMgr::GetOwnedFiles() failed Registry access failed: RPM attempted to get job status. 

259 CQMgr::GetOwnedFiles() failed Registry access failed: RPM attempted to get job status. 

261 CQMgr::GetMatchingFiles() failed Registry access failed: RPM attempted to get job status. 

265 CQMgr::GetMatchingFiles() failed Registry access failed: RPM attempted to get job status. 

267 CQMgr::ShowStatus() failed Registry access failed: RPM attempted to get job status. 

268 CQMgr::GetLocalDataPath() failed Registry access failed: RPM attempted to get the local 
data path for a job. 

269 CQMgr::GetProcessType() failed Registry access failed: RPM attempted to get a data file’s 
LPD type. 

271 CQMgr::RemoveJob() failed Registry access failed: RPM attempted to remove a job. 

273 CQMgr::GetSeqno() failed Registry access failed: RPM attempted to get a sequence 
number. 

279 CQMgr::ControlFileData() failed Registry access failed: RPM attempted to get a job’s 
control file name. 

283 CQMgr::IsDone() failed Registry access failed: RPM attempted to determine if a 
job transfer was complete. 

289 CQMgr::Prod() failed Registry access failed: RPM attempted to schedule 
printing. 

291 CQMgr::ControlFileName() failed Registry access failed: RPM attempted to look up a job’s 
control file name. 

292 Creating file <path> 0x<id> : <text> Windows returned an error when RPM attempted to 
create a spool file. 

293 CQMgr::DataFileName() failed Registry access failed: RPM attempted to create a spool 
file name. 

295 CQMgr::DeleteJob() failed Registry access failed: RPM attempted to delete a job. 

296 CQMgr::DeleteJob() failed Registry access failed: RPM attempted to determine if a 
job was transferring. 

297 CQMgr::GetCurrentFileNo() failed Registry access failed: RPM attempted to get a job’s 
current file number. 

298 CQMgr::SetCurrentFileNo() failed Registry access failed: RPM attempted to set a job’s 
current file number. 

299 CQMgr::GetQueueType() failed Registry access failed: RPM attempted to determine a 
queue’s type. 

300 CQMgr::GetRequests() failed Registry access failed: RPM attempted to determine a 
job’s data file count. 

301 CQMgr::GetPrintDevice() failed Registry access failed: RPM attempted to look up a 
queue’s printer. 

303 CQMgr::PutPrintDevice() failed Registry access failed: RPM attempted to set a queue’s 
printer. 

305 CQMgr::GetDeviceMode() failed Registry access failed: RPM attempted to get a queue’s 
printer setup. 

306 CQMgr::PutDeviceMode() failed Registry access failed: RPM attempted to set a queue’s 
printer setup. 

307 CQMgr::AddQueue() failed Registry access failed: RPM attempted to add a queue. 

308 CQMgr::GetCFNames() failed Registry access failed: RPM attempted to get data file 
names. 
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309 Trying to change directory to an empty directory RPM is trying to change the current directory to “”. 

310 Failed to change to drive <drive>: RPM could not change the current drive. 

311 CQMgr::RemovePrinterConfig() failed Registry access failed: RPM attempted to remove a 
printer selection and its setup. 

312 CQMgr::MoveJob() failed Registry access failed: RPM attempted to move a job to 
another queue. 

313 CQMgr::SetDone() failed Registry access failed: RPM attempted to decide that a 
job’s transfer was complete. 

314 CFilterContact::SetFilterData() failed Registry access failed: RPM attempted to initialize a 
filter. 

315 CFilterContact::Done() failed Registry access failed: RPM attempted to clean up after 
filter execution. 

316 CQMgr::GetProfileFont() failed Registry access failed: RPM attempted to get font 
settings. 

317 CQMgr::WriteProfileFont() failed Registry access failed: RPM attempted to set font 
settings. 

318 Problem with printer '<name>’, suspending queue 
'<queue>' 0x<id> : <text> 

Error when RPM attempted to open an information 
context for the printer. 

320 Printer limit (<limit>) exceeded for queue <queue>, 
printer '<printer>' 

The printer limit would be exceeded. 

321 Unknown queue type <type> RPM does not understand the queue type.  Could be 
registry problems. 

322 Printing -- data file <path> 0x<id> : <text> RPM cannot access the file.  A file protection problem 
exists. 

323 Printing -- data file '<path>' is empty RPM encountered an empty data file. 

325 CQMgr::GetStatus() failed Registry access failed: RPM attempted to read a queue’s 
stored status. 

326 CQMgr::SetStatus() failed Registry access failed: RPM attempted to set a queue’s 
stored status. 

327 Unable to open printer '<printer>' (suspending 
queue) 0x<id> : <text> 

Windows returned an error when RPM tried to open the 
printer for raw printing. 

328 Unable to spool file '<path>' 0x<id> : <text> Windows returned an error when RPM tried to start the 
raw document. 

329 StartPagePrinter() <path> 0x<id> : <text> Windows returned an error when RPM tried to start the 
raw page. 

330 Spooling file '<path>' 0x<id> : <text> Windows returned an error when RPM tried to spool the 
raw job. 

333 RPM is holding job <job> Starting page was 
<start>, last page is <end> 

The end of the job was encountered before expected. 

336 Spooling file '<path>' 0x<id> : <text> Windows returned an error when RPM was spooling raw 
data. 

337 EndPagePrinter() 0x<id> : <text> Windows returned an error when RPM ended a raw page. 

338 EndDocPrinter() 0x<id> : <text> Windows returned an error when RPM ended a raw 
document. 

339 ClosePrinter() 0x<id> : <text> Windows returned an error when RPM closed the printer. 

340 CTextSetup::GetSettings() failed Registry access failed: RPM attempted to get a queue’s 
text settings. 

348 Unknown SCS tag: <tag> RPM encountered an unknown SCS markup. 

352 Unable to print binary file; check data options or 
change queue type 

RPM encountered too long a line and concluded the file is 
not text. 

353 Can't start document printing: 0x<id> : <text> Windows returned an error when RPM attempted to start 
the text document. 

355 Print error ending page: 0x<id> : <text> Windows returned an error when RPM attempted to end 
a text page. 

356 RPM is holding job <job> Starting page was 
<start>, last page is <end> 

The requested starting page was beyond the end of the 
document. 

357 RPM is holding job <job> found nothing to print The processed text document was empty. 

358 Print error ending document: 0x<id> : <text> Windows returned an error when RPM attempted to end 
the text document. 

362 Port <x> couldn't initialize connection RPM could not initialize a network connection. 
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363 CreateServerSockets() failed Registry access failed: RPM attempted to create 
protocols. 

364 Unknown protocol <name> RPM does not know about the protocol.  RPM’s registry 
could be corrupt. 

363 Socket <x> rejecting job on queue <queue> 
couldn't read security options 

Registry access failed: RPM attempted to read LPD 
security options. 

368 Socket <x> rejecting job on queue <queue> 
couldn't read host information 

RPM couldn’t obtain the client’s IP address from the 
socket. 

369 Client protocol: AF_INET is required The client is trying to establish a session using a different 
network protocol. 

370 Client port <x> out of range “Relax Port In Range” is not selected and the client’s port 
is above 1024. 

371 Socket <x> rejecting job on queue <queue> 
Permission denied 

Access checking is enabled: The connected client is 
denied access. 

372 Socket <x> rejecting job on queue <queue> queue 
validation failed 

Registry access failed: RPM checked whether the queue 
exists. 

373 CDataTransform::GetLangStr() failed Registry access failed: RPM was getting the EBCDIC 
language string. 

374 CDataTransform::GetLangStr() failed Registry access failed: RPM was getting the EBCDIC 
language string. 

375 CDataTransform::GetLangStr() failed Registry access failed: RPM was getting the EBCDIC 
language string. 

376 CEBCDIC::SetQueue() failed Registry access failed: RPM was initializing an EBCDIC 
translation. 

378 CXlatMgr::SetTableContents() failed Registry access failed: RPM was initializing a translation. 

379 CXlatMgr::RemoveTable() failed Registry access failed: RPM was removing a translation. 

380 CXlatMgr::RemoveTable() failed Registry access failed: RPM was removing a translation. 

381 CXlatMgr::CXlatMgr() failed Registry access failed: RPM was initializing a translation. 

382 RpmLpdAgent::QueueState() failed Registry access failed: RPM was reporting queue status. 

385 Couldn't open data file RPM couldn’t open a file for transferred data. 

386 Error writing data file <id> : <text> Windows returned an error while RPM was writing 
transferred data to a file. 

389 Queue not defined for protocol '<protocol>' The queue is not defined for the telnet protocol. 

390 TelnetAgent::StartTelnetPrint() failed Registry access failed: RPM was scheduling a telnet print 
job. 

393 CQMgr::GetWideDeviceMode() failed Registry access failed: RPM was getting printer setup. 

394 Invalid LOGFONT size <size> (data is LOGFONT 
structure) 

ont data is corrupt. 

395 Truncating job <job> RPM is truncating an incomplete job because the client 
disconnected. 

396 RpmLpdAgent::OnAbnormalTermination() failed RPM was patching a job after an unexpected client 
termination. 

401 Couldn't open log file <path> for append RPM could not open its log file. 

402 Couldn't write log file <path> RPM couldn’t append an event to its log file. 

403 Couldn't get log file name RPM couldn’t determine the log file name when purging 
logs. 

404 Purging log file <path> 0x<id> : <text> Windows returned an error while RPM was purging log 
files. 

406 Couldn't get log file name RPM couldn’t determine the log file name when purging 
logs. 

407 Couldn't create log directory <path> RPM couldn’t create the directory for the logs. 

408 Couldn't open log file <path> RPM couldn’t open the log file. 

411 No printer is configured for queue <queue> Choose “Printer Setup” off the “Edit Queues” dialog. 

413 Error on printer info for '<printer>' 0x<id> : <text> Error when RPM tried to open an information context to 
check the printer status. 

414 Aborting raw print job <job> RPM is aborting the raw print job because the system is 
shutting down. 

416 Aborting text print job RPM is aborting the text print job because the system is 
shutting down. 
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420 Socket <socket> connected to host <ip> auto-
created queue <queue> 

RPM automatically created the referenced queue. 

424 Queue <queue> is active RPM cannot delete the queue because it is busy 
transferring or printing a job. 

425 CQMgr::AutoCreateQueue() failed Registry access failed: RPM was auto-creating a queue. 

430 The license is not valid for this product RPM found an invalid license. 

447 Unable to open printer '<name>' with full access 
(disabling job management) 0x<code> : <text> 

Windows error when RPM attempted to open the printer 
with full access. 

448 Unable to open printer '<name>' with full access 
(disabling job management) 0x<code> : <text> 

Windows error when RPM attempted to open the printer 
with full access. 

451 RPM needs Full Access to printer <name> 0x<code> 
: <text> 

Windows error when RPM attempted to open the printer 
with full access. 

452 RPM needs Full Access to printer <name> 0x<code> 
: <text> 

Windows error when RPM attempted to open the printer 
with full access. 
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New in This Version 
Version 4.5 Elite and Select 

Remote Print Administrator (RPA) 
1. Provides remote administration through web browser  
2. Comprehensive management of queues, jobs and other settings  
3. View logs for remote troubleshooting  
  Note: Currently available with RPM Elite only. 

Brooks License Manager 
1. License Wizard enhances ease of use  
2. Supports advanced products and features  
3. Enhanced support for license reinstallation  
4. Web-unlock can connect through a proxy server/firewall  

User Interface 
1. Displays long job names  
2. Updated default settings  
3. Added support for importing and exporting configuration  
4. Changed "Resume" to "Suspend"  
5. Enhanced support for specifying control file destination  
6. Help file updated  
7. Filter queue disables printer selection  

Core 
1. Supports banner page for all queue types  
2. Improved file handling  
3. Updated default settings  
4. Allows insertion of bytes or files before or after banner page  
5. Support for latest version of Report2Web  

Issues Resolved 
1. Resolved issue with opening and closing queue display  
2. Resolved issue with preserving more than 7 days of log files  
3. Resolved issue where dialogs were not using correct system colors  
4. Resolved many issues with imbedded null characters, including ASA translations  
5. Resolved issue with blank page handling 
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Glossary 
 
Host name:  A host name is the name assigned to a host computer on a TCP/IP network. It must be unique on the 
network.  Sometimes it is a one-part name, for instance, ws48 has only one part. At other times you might need to use a 
fully qualified name, such as ws48.brooksnet.com; this example is multipart. Your network staff can advise you on this. 
 
Often, you can substitute the IP address for a host name. Ask your network staff for assistance with this. 
 
Print job: RPM can receive several kinds of requests. One of these requests actually results in printing, so it is referred 
to as a print job. The other requests RPM might receive result in RPM returning status information, and sometimes 
performing an action on a queue or one or more jobs. 
 
RPM spends most of its time dealing with print jobs. First it receives a print job, each of which contains several parts 
(see "Files created by RPM" on page 12). Then RPM stores it in a queue, and later processes it. Finally, RPM removes 
the job. 
 
Queue: In RPM, a queue is a list of print jobs, each with a common destination. RPM queues are uniquely identified by 
their name.  Each queue has characteristics that you can set in the Edit Queues dialog (see page 38). For instance, two 
queues might use the same Windows printer, but each queue might use different fonts, or one might use portrait and the 
other landscape. 
 
Queue name: Each queue has its own unique name.  Queue names cannot contain "white space", that is, spaces or tabs. 
This would violate the LPD Protocol specification, which describes how information is passed between print clients 
and servers.  RPM treats queue names as case insensitive, that is, upper or lower case does not matter. For instance, you 
can define the queue "lp" and clients can use queue "LP" or "Lp"; these letter combinations all refer to the same queue. 
 
Root directory: The root directory in a file system typically relates to the top-most level.  The RPM root signifies the 
directory in which RPM is installed.  The RPM root plays many roles in RPM.  It contains the program executables for 
both the service and the user interface.  It also contains the most Spool and Logfiles directories.  Future versions of 
RPM may create other directories in the root directory. 
 
Sequence number: RPM assigns a sequence number to each print job, based on information found in the queue.ini file 
in the queue directory. You may notice this number in the Queue Status window (see page 14) in the far left column. 
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ASCII Codes 
ANSI Character Set (Character Codes 0-255) 
 
Dec Hex Char Code† 
0 00 � NUL 
1 01 � SOH 
2 02 � STX 
3 03 � ETX 
4 04 � EOT 
5 05 � ENQ 
6 06 � ACK 
7 07 � BEL 
8 08 � BS 
9 09 � HT 
10 0A � LF 
11 0B � VT 
12 0C � FF 
13 0D � CR 
14 0E � SO 
15 0F � SI 
16 10 � SLE 
17 11 � CS1 
18 12 � DC2 
19 13 � DC3 
20 14 � DC4 
21 15 � NAK 
22 16 � SYN 
23 17 � ETB 
24 18 � CAN 
25 19 � EM 
26 1A � SIB 
27 1B � ESC 
28 1C � FS 
29 1D � GS 
30 1E � RS 
31 1F � US 
32 20 (space)  
33 21 !  
34 22 "  
35 23 #  
36 24 $  
37 25 %  
38 26 &  
39 27 '  
40 28 (  
41 29 )  
42 2A *  
43 2B +  
44 2C ,  
45 2D -  

46 2E .  
47 2F /  
48 30 0  
49 31 1  
50 32 2  
51 33 3  
52 34 4  
53 35 5  
54 36 6  
55 37 7  
56 38 8  
57 39 9  
58 3A :  
59 3B ;  
60 3C <  
61 3D =  
62 3E >  
63 3F ?  
64 40 @  
65 41 A  
66 42 B  
67 43 C  
68 44 D  
69 45 E  
70 46 F  
71 47 G  
72 48 H  
73 49 I  
74 4A J  
75 4B K  
76 4C L  
77 4D M  
78 4E N  
79 4F O  
80 50 P  
81 51 Q  
82 52 R  
83 53 S  
84 54 T  
85 55 U  
86 56 V  
87 57 W  
88 58 X  
89 59 Y  
90 5A Z  
91 5B [  
92 5C \  

93 5D ]  
94 5E ^  
95 5F _  
96 60 '  
97 61 a  
98 62 b  
99 63 c  
100 64 d  
101 65 e  
102 66 f  
103 67 g  
104 68 h  
105 69 i  
106 6A j  
107 6B k  
108 6C l  
109 6D m  
110 6E n  
111 6F o  
112 70 p  
113 72 q  
114 72 r  
115 73 s  
116 74 t  
117 75 u  
118 76 v  
119 77 w  
120 78 x  
121 79 y  
122 7A z  
123 7B {  
124 7C |  
125 7D }  
126 7E ~  
127 7F �  
128 80 € 
129 81 � 
130* 82 ‚ 
131* 83 ƒ 
132* 84 " 
133* 85 ... 
134* 86 † 
135* 87 ‡ 
136* 88 ˆ 
137* 89 ‰ 
138* 8A Š 
139* 8B ‹ 
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140* 8C Œ 
141 8D � 
142 8E Ž 
143 8F � 
144 90 � 
145 91 ' 
146 92 ' 
147* 93 " 
148* 94 " 
149* 95 • 
150* 96 - 
151* 97 - 
152* 98 ˜ 
153* 99 ™ 
154* 9A š 
155* 9B › 
156* 9C œ 
157 9D � 
158 9E � 
159* 9F Ÿ 
160 A0   
161 A1 ¡ 
162 A2 ¢ 
163 A3 £ 
164 A4 ¤ 
165 A5 ¥ 
166 A6 ¦ 
167 A7 § 
168 A8 ¨ 
169 A9 © 
170 AA ª 
171 AB " 
172 AC ¬ 
173 AD - 
174 AE ® 
175 AF ¯ 
176 B0 ° 
177 B1 ± 
178 B2 ² 

179 B3 ³ 
180 B4 ´ 
181 B5 µ 
182 B6 ¶ 
183 B7 · 
184 B8 ¸ 
185 B9 ¹ 
186 BA º 
187 BB " 
188 BC 1/4 
189 BD 1/2 
190 BE 3/4 
191 BF ¿ 
192 C0 À 
193 C1 Á 
194 C2 Â 
195 C3 Ã 
196 C4 Ä 
197 C5 Å 
198 C6 Æ 
199 C7 Ç 
200 C8 È 
201 C9 É 
202 CA Ê 
203 CB Ë 
204 CC Ì 
205 CD Í 
206 CE Î 
207 CF Ï 
208 D0 Ð 
209 D1 Ñ 
210 D2 Ò 
211 D3 Ó 
212 D4 Ô 
213 D5 Õ 
214 D6 Ö 
215 D7 × 
216 D8 Ø 
217 D9 Ù 

218 DA Ú 
219 DB Û 
220 DC Ü 
221 DD Ý 
222 DE Þ 
223 DF ß 
224 E0 à 
225 E1 á 
226 E2 â 
227 E3 ã 
228 E4 ä 
229 E5 å 
230 E6 æ 
231 E7 ç 
232 E8 è 
233 E9 é 
234 EA ê 
235 EB ë 
236 EC ì 
237 ED í 
238 EE î 
239 EF ï 
240 F0 ð 
241 F1 ñ 
242 F2 ò 
243 F3 ó 
244 F4 ô 
245 F5 õ 
246 F6 ö 
247 F7 ÷ 
248 F8 ø 
249 F9 ù 
250 FA ú 
251 FB û 
252 FC ü 
253 FD ý 
254 FE þ 
255 FF ÿ 

 
� Indicates that this character is not supported by Windows. 
• Indicates that this character is available only in TrueType fonts. 
 
† The "Code" column is meaningful only for characters 1-31. 


